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About rekordbox 

Overview of rekordbox 

rekordbox is the name of software to manage music files to be played on Pioneer DJ Players. 

 rekordbox may be used for classifying and searching for music files stored on your computer 

as well as creating playlists, all of which can help improve your DJ performance. 

 rekordbox allows the detecting, measuring, and editing of beats, tempos (BPM), and other 

elements of your music files prior to a performance. 

 rekordbox may be used to set and store detailed point information (for cueing, looping, hot 

cueing, etc.) prior to a performance. 

Not only can various types of point information and playlists prepared with rekordbox be used for 

playback on Pioneer DJ players, the playback history, number of times played, point information, 

etc., can also be fed back to rekordbox after playback. 
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Features of rekordbox 

Music files are automatically analyzed, enabling advanced DJ performance 

 MUSIC FILE ANALYSIS 

By analyzing music files with rekordbox, you can obtain and display a variety of data during DJ 

performances, including waveforms, beats and tempos (BPM). For example: 

 When analyzed music files are loaded into a DJ player, the waveform information is displayed 

immediately to provide the DJ with a visual of the track. 

 The quantize function of rekordbox or a DJ player 

(e.g. CDJ-2000nexus, CDJ-900nexus, CDJ-2000, CDJ-900, XDJ-AERO, XDJ-R1) can be 

used to easily set accurate cues and loops. 

 Accurate, stable BPM information can be displayed and checked instantaneously. In addition, 

the beat sync function can be used to mix sound synchronizing the tempos (BPM) and beats 

of multiple DJ players (e.g. CDJ-2000nexus) or the left and right decks 

(e.g. XDJ-AERO, XDJ-R1). 

 

The functions that can be used in association with Pioneer DJ units and rekordboxdepend on 

the DJ units you are using. 

 BEAT GRID 

The beat positions (beats) detected when music files are analyzed are displayed as a grid of 

lines on the enlarged wave form display. 

 QUANTIZE 

         

rekordbox can be used to detect and adjust the beat patterns of your music files before you 

perform with your DJ unit. This allows you to set and play cues, loops, and effects exactly on 

beat with your DJ unit, by automatically correcting any timing mistakes that are made when you 

press buttons. 
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 CUE/LOOP POINT MEMORY 

        *1 

Cue and loop points can be set and stored ahead of time with rekordbox and then called on the 

DJ player. Up to 10 cue/loop points per music file can be saved withrekordbox. Also, loops 

created with rekordbox can be extracted and output to WAVE files. 

 *1 This function is available only for the cue point closest to the beginning of a track. 

 HOT CUE 

   

Hot cues that you stored beforehand using rekordbox can be called on your DJ player. 

With rekordbox, up to three hot cues can be stored per music file. 

 HOT CUE BANK LIST 

  

With rekordbox, combinations of the three hot cues (A, B and C) you want to use on the DJ 

player can be created as hot cue bank lists. Cues from different music files can be combined and 

registered in hot cue bank lists. 

Multiple lists may be prepared, allowing you to quickly access a greater number of hot cue 

combinations than ever before on your DJ players. 

 BEAT SYNC 

    

By analyzing music files using rekordbox, it is possible to use a wide variety of effects and to mix 

the sound synchronizing the tempos (BPM) and beats between multiple DJ players (or between 

the left and right decks), greatly expanding the range of DJ performances. 
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Setting track information to allow for easy browsing on your DJ player 

 LIBRARY BROWSE 

         

rekordbox can be used to set display categories and sorting criteria. When these items are set 

with rekordbox, you can display, sort, and search music files by using the DJ player’s library 

browse function (browsing by genre, BPM, etc.). 

 PLAYLIST 

         

By creating playlists of your favorite music files in advance using rekordbox, the desired tracks 

can be searched for quickly on your DJ player. 

 TAG LIST 

     

In addition to playlists, music files you plan to play soon can be collected temporarily in 

the rekordbox tag list. The rekordbox tag list can be shared on-line between your computer and 

any DJ players connected on a LAN. This function is convenient for selecting tracks during live 

performances using multiple DJ players alternately. 

 

Linking and sharing music files and data with DJ units 

 USB EXPORT 

         

You can deliver music files and their related data saved with rekordbox to your DJ player by 

using USB devices (flash memory or hard disk) without the hassle of bringing your computer to 

the DJ booth. In addition to USB devices, SD memory cards can be used for some DJ players 

(e.g. CDJ-2000nexus or CDJ-2000). 
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 LINK EXPORT 

     

You can load music files or data saved on rekordbox onto a DJ player in real time if you connect 

a computer to the DJ player with a LAN cable or wireless LAN. 

For instructions on connections, see the Operating Instructions for each specific DJ player and 

computer. 

 PRO DJ LINK 

       

You can share rekordbox music files and data with a DJ mixer and multiple DJ players by 

establishing a PRO DJ LINK connection with LAN cables. Up to four DJ players can be 

connected. 

Also, up to two computers which are running rekordbox can be connected at the same time, 

allowing for seamless DJ rotation.Note that depending on the LAN configuration and DJ player’s 

specifications, communications can be established with up to six computers (two by wired 

connection, four by wireless connection). 

 LINK MONITOR 

   

rekordbox music files can be monitored over the headphones of a DJ mixer which is connected 

by PRO DJ LINK. 

 

Saving track playback information from your DJ player for current review or 

future reference of DJ performance 

 HISTORY/PLAYLIST 

        

rekordbox can be updated with histories of all tracks played during each session on your DJ 

player and with playlists created on your DJ player. 
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Synchronizing external libraries to manage music files 

 SYNC MANAGER 

If iTunes and USB devices are synchronized with rekordbox, you can easily export playlists to 

such devices in an updated status. 

 

Many handy features for efficient selection of a track 

 PLAYLIST PALETTE 

Showing 4 playlists simultaneously allows you to quickly and efficiently classify your music files. 

 MY TAG 

You can create tags for your music files by adding tracks’ detailed genres, features and 

comments as you wish. 

My Tag filter allows you to refine your search using tags as search criteria. 

 RELATED TRACKS 

Music files suggested for the track to be played next are listed based on the selected criteria 

such as BPM and key. 

 PREVIEW 

You can preview a music file by clicking a waveform or an artwork displayed in the track list 

without loading a track to the Player. 

 2 PLAYERS 

Two players can be displayed in 2 Player mode to allow 2 tracks to be played at the same time. 
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Using rekordbox to prepare for playback 

Install rekordbox on your computer from the CD-ROM included with the Pioneer DJ player 

(CDJ-2000nexus, CDJ-2000, CDJ-900nexus, CDJ-900, CDJ-850, CDJ-350, XDJ-AERO orXDJ-

R1). For information on the rekordbox software license agreement, the minimum required 

operating environment, the installation procedure, etc., see the separately included document, 

“Read Before Use”. 

 The installation program can also be downloaded from the rekordbox online support site. 

The rekordbox software license agreement, the minimum required operating environment, 

the installation procedure, etc., can also be viewed on the rekordbox online support site. 

 

1. Import music files into your computer. 

Have music files ready on your computer. 

 rekordbox does not allow you to import music files from audio CDs or purchase music files 

over the Internet. It is recommended to have music files ready on your computer which 

have been imported by another application. 

2. Add music files to the collection on rekordbox. 

Analyze and measure the beat and tempo (BPM) of a music file. 

 You can import the tag information of music files (e.g. MP3, AAC, WAV, AIFF) as well as 

information on music files from the iTunes library. 

3. Make the preparations using rekordbox. 

Set various performance points (cue, loop, and hot cue). 
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Create lists to be used for performance (playlists and hot cue bank lists). 

 You can import playlists (M3U, M3U8) created by other software as well as those in 

[iTunes] and [rekordbox xml]. 

4. Play in combination with DJ units. 

Playback on Pioneer DJ units is possible using the point information and playlists prepared 

with rekordbox. 

 The Pioneer DJ player’s playback history, number of times played, point information, etc., 

can be fed back to rekordbox. 

 

Using mobile devices to prepare for playback 

 

Music files that have been analyzed with rekordbox, playlists and My Settings contents created 

with rekordbox, etc., can be transferred to mobile devices (e.g. iPhones, Android™ devices.). Also, 

music data that has been edited on mobile devices can be reflected in rekordbox. 

 rekordbox must also be installed on the mobile device. The mobile device version 

ofrekordbox can be downloaded onto the mobile device from online software markets, such 

as App Store and Google Play. 

 For the functions that can be used with mobile devices, see the user’s manual of the mobile 

device version of rekordbox. 

 For instructions on making wireless LAN connections, see the operating instructions of your 

mobile device, computer or wireless LAN device. 
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Using rekordbox in combination with DJ units 

Be sure to read the information on “Safety Precautions” and “Connections” in the Operating 

Instructions for each respective DJ unit before connecting the unit(s) to your computer. 

To check the compatibility of SD memory cards and USB devices (flash memory or hard disk) 

with your Pioneer DJ players, see the Operating Instructions for each specific DJ player. 

The latest information on Pioneer DJ players that can be used with rekordbox, is available on 

the rekordbox online support site. 

Playback with a USB device (USB EXPORT) 

         

 

You can deliver music files and their related data saved with rekordbox to your DJ player by 

using USB devices (flash memory or hard disk) without the hassle of bringing your computer to 

the DJ booth. 

 In addition to USB devices, SD memory cards can be used for some DJ players 

(e.g.CDJ-2000nexus or CDJ-2000). 
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Playback connected to a LAN (LINK EXPORT) 

     

 

You can load music files or data saved on rekordbox onto a DJ player in real time if you connect 

a computer to the DJ player with a LAN cable or wireless LAN. 

 For instructions on connections, see the Operating Instructions for each specific DJ player 

and computer. 

 

Playing in conjunction with multiple DJ units (PRO DJ LINK) 

       

 

When a PRO DJ LINK-compatible DJ mixer and DJ player(s) are connected by LAN 

cable, rekordbox music files and data stored on a USB device can be transferred to up to four DJ 

players. 

 In addition to USB devices, SD memory cards can be used for some DJ players 

(e.g.CDJ-2000nexus or CDJ-2000). 

 A switching hub can be used in place of a DJ mixer. 

 For instructions on connections, see the Operating Instructions for each specific DJ unit. 
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When a computer on which rekordbox is installed is connected by PRO DJ LINK using a LAN 

cable, rekordbox music files and data can be loaded in real time on up to four DJ players. 

Also, when a DJ mixer supporting PRO DJ LINK and a computer on which rekordbox is installed 

are connected using a LAN cable, rekordbox music files can be monitored over headphones 

connected to the DJ mixer. 

 A switching hub can be used in place of a DJ mixer. 

 Up to two computers can be connected by PRO DJ LINK. 

 For instructions on connections, see the Operating Instructions for each respective DJ unit 

and computer. 
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Names of parts 

Player panel 

 One Player mode 

 

 /  

 Click  to jump forward from the current playback position. 

 Click  to jump backward from the current playback position. 

 /  

Moves to the beginning of a track (track search). 

 Click  to move to the beginning of the next track. 

 Click  to jump to the beginning of the currently playing track. Click twice to jump 

back to the previous track. 

 QUANTIZE 

Sets cue and loop points to the nearest beat grid point. 

 Artwork 

Displays the artwork images of music files. 
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 +/  /– 

Zooms enlarged waveform displays in or out. 

 Track information display 

Displays the title, artist and key of the music file loaded to the player. 

 Enlarged waveform display 

The playing position can be moved forward and backward by dragging the displayed 

waveform left and right. 

Beat positions detected by analyzing the music file are displayed as vertical lines. 

 Playing address and full waveform display 

The current play position is indicated using a thin vertical line which is displayed over the 

waveform, and a horizontal bar displayed below the waveform to represent the progress of 

the track. 

 The horizontal bar lights up from the left side when in the time elapsed mode. 

 The horizontal bar turns off from the left side when in the time remaining mode. 

 Total time 

Displays the total time of the track now playing. 

 Time display in minute (M) and second (S) 

Click the time display to toggle between elapsed time and remaining time [–]. 

 BPM display 

Displays BPM (Beats Per Minute) of the track currently being played. 
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 Player panel display selector 

Switches the player panel display on and off. 

 : One player is displayed in the Player panel. 

 : Two players are displayed in the Player panel. 

 : A simple player is displayed in the Player panel. 

 : Hide the Player panel. 

 Menu button 

Click this icon to open a menu to select the color of enlarged waveform, to analyze the 

currently playing track, and to export it to a device. 

 Mute 

Click to mute the sound. Click again to cancel mute. 

 Volume 

Drag up and down to adjust the volume. 

 Preferences 

Opens the [Preferences] screen. 

 Current time display 

Displays the current time on your computer clock. 

 The sub-panel for the loaded track 

Displays information of the track now loaded to the player and comments for [MEMORY] and 

[HOT CUE]. 

 Function panel 

Click the buttons to switch the function panel between [CUE/LOOP] and [GRID]. 

 CUE 

Sets cue points. 
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Starts or pauses playback. 

  

Select the beat length when clicking  and  to jump from the current position. 

 Two Player mode 

 Please see [One Player mode] for the items which are not explained here. 

 

 Function panel show/hide button 

Click this icon to show or hide the Function panel. 

 MEMORY 

Stores cue and loop points that have been set. 

 BEAT SYNC MASTER 

[MASTER] is displayed in the Master player for Beat Sync. 

 TEMPO Adjustment 

Use this to adjust the track playing speed. 

  

Click this icon if two tracks in Player A and B are in a good match. 
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 BEAT SYNC 

Use this to turn on the beat sync function. 

 Pitch bend 

Press and hold these buttons for pitch bend while playing the track. Hold  to speed up 

the playback and hold  to slow it down. 

 TEMPO RESET 

Reset the tempo to the original BPM. 

 MASTER TEMPO 

Use this to turn the master tempo function on and off. 

 Crossfader 

Adjusts the mix balance of Player A and B. 
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The sub-panel for the loaded track 

 MEMORY panel 

Lists all the saved cue and loop points. 

 

  

When you save a loop point, this icon appears. 

Click this icon to set an active loop; then, the icon turns red. 

 MEMORY 

Click this icon to show the [MEMORY] panel in the sub-panel for the loaded track. 

 Cue/Loop Call button 

Shows (minute:second:millisecond) where a cue or loop point is set. 

Click the time to jump to each cue or loop point. 

 Cue/Loop Delete button 

Deletes saved cue or loop points. 

 Comment 

Shows comments of saved cues or loops. You can edit them. 

Right click to change the cue marker color. 
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 HOT CUE panel 

All the saved hot cues are listed. 

 

 [A], [B], [C] 

Displays HOT CUE [A], [B] and [C]. If a green icon is lit, a cue is saved there, if an orange 

icon is lit, a loop is saved and if an icon is dimmed in gray, it is empty. 

 Hot Cue save/call button 

Shows (minute:second:millisecond) where a hot cue point is set. Click the time to jump to the 

saved hot cue point. 

If it is empty, click this button, and Hot Cue will be saved. 

 HOT CUE DELETE button 

Deletes the stored hot cue. 

 HOT CUE 

Click this icon to show the HOT CUE panel in the sub-panel for the loaded track. 

 Comment 

Shows a comment of stored hot cues. You can edit them. 
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 INFO panel 

Displays information of a track loaded to the player. 

 

 Track information display 

Displays detailed information of the track loaded to the player. 

 INFO 

Click this icon to show the INFO panel in the sub-panel for the loaded track. 

Function panel 

Click the buttons to switch the function panel between [CUE/LOOP] and [GRID]. 

 CUE/LOOP panel 

Sets and saves Hot Cue, Loop and Cue. 

 

 CUE/LOOP 

Click this icon to open the CUE/LOOP panel in the function panel. 

 HOT CUE DELETE 

Deletes the stored hot cue. 
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 HOT CUE (A, B, C) 

Hot cues are stored here. 

 LOOP IN/LOOP OUT 

Sets realtime cues and loop in/loop out points. 

 RELOOP/EXIT 

Cancels or resumes loop playback. 

 Auto Beat Loop (1/32, 1/16, 1/8, 1/4, 1/2, 1, 4, 8, 16, 32) 

Sets the loop length by the specified number of beats. 

 /2 

Click this icon to halve the length of the currently playing loop. 

 x2 

Click this icon to double the length of the currently playing loop. 

 MEMORY 

Stores cue and loop points that have been set. 

  

Jumps to a saved cue or loop point. 

 Click  to jump to a saved cue or loop point after the currently playing position. 

 Click  to jump to a saved cue or loop point before the currently playing position. 

 Cue/Loop Delete button 

Click this icon to delete a saved cue or loop position. 
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 GRID panel 

Adjusts beatgrid. 

 

 GRID 

Click this icon to open the [GRID] panel. 

  

Plays track with a metronome in synchronization with the beat grid. 

  

Undoes what you did last in the GRID panel. 

  

Reduces beat grid intervals by 1 msec. 

  

Expands beat grid intervals by 1 msec. 

  

Moves the beat grid 1 msec to the left. 
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The entire beat grid is slid to match the nearest beat position to the current playback position 

shown in a white vertical line at the center of the waveform. 

  

Moves the beat grid 1 msec to the right. 

  

Doubles the number of beats (BPM). (The length of each beat grid interval is reduced by 

half.) 

  

Cuts the number of beats (BPM) in half. (The length of each beat grid interval is doubled.) 

  

Cancels the temporarily marked position for adjusting the beat grid. 

  

Temporarily marks the base position for adjusting the beat grid points. 

  

Changes the length of each beat grid interval based on the number of beats (BPM) that is 

input. 
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Click this icon to manually set BPM. 

Browser panel 

 

 Shortcut 

Drag a folder or a playlist in the tree view, and drop it in a slot to make a shortcut. 

 Playlist path 

This icon will appear if a track highlighted in the track list is stored in playlist(s). Click to 

show a list of playlist path(s). 

 Playlist palette 

If you click the  icon, a tag list or four playlists will be displayed. 

 Three palettes on the right among the 4 palettes are the playlist palettes. The far left 

palette is used as Tag List. 

 Artwork switch 

Click one of the following button to select the artwork mode. 

: Shows upper part of the artwork. 

: Shows the whole artwork. 
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 Category filter 

Searches for music files using the category filter. 

 My Tag filter 

Click to show My Tag filter and search track files using My Tag added to them. 

 Search filter 

Searches for music files using the search filter. 

 Column header 

Sorts and enables searching of music file information. 

The display of column headers can be turned on and off and their order can be changed. 

 My Tag 

Click the icon to display My Tag settings pane on the right side of track list. 

 RELATED TRACKS 

Click the icon to show tracks suggested to be played next in the right side of track list. 

 Info 

Click to open the information pane on the right side of the track list to show the currently 

selected music file. 

 Track list 

Displayes music files in a playlist selected in the tree view. 
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 Tree View 

Select an item to be displayed in the track list. 

Collection Displays all the music files imported to rekordbox. 

Playilsts 
You can organize the music collection on rekordbox by creating a Playlist prior to 

performance. 

H. Cue Bank 
Hot cue points you have set even in different tracks can be saved 

in A, B and C of of hot cue bank. 

iTunes iTunes library can be referred to and displayed. 

rekordbox xml rekordbox XML format can be referred to and displayed. 

Explorer 
Displays folder layers of your computer and external devices such as a USB flash 

drive. 

Device Displays USB devices, SD cards and mobile devices. 

Histories Displays the playback history of CDJ. 

Whether [H. Cue Bank], [iTunes], [rekordbox xml] and [Explorer] are displayed or hidden can be se-

lected in [View] > [Layout] in the [Preferences] screen. 

 Sync Manager 

Click this icon to open the Sync Manager panel. 

Synchronize rekordbox with external libraries. 

 LINK 

Enables communications with DJ units 

(e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus,CDJ-900, XDJ-AERO) connected by LAN 

cable or wireless LAN. 
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Link status panel 

 

 LINK 

Terminates communications with DJ units 

(e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus, CDJ-900, XDJ-AERO) connected by LAN 

cable or wireless LAN. 

 Sync master 

When playing DJ players (e.g. CDJ-2000nexus) using the beat sync function, synchronizes 

using the master BPM (tempo) specified with rekordbox. 

 Master BPM 

Specifies the tempo (BPM) used for the sync master. 

 Link Status 

Displays the status of DJ units 

(e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus, CDJ-900, XDJ-AERO) connected by LAN 

cable or wireless LAN at the bottom of the browser panel. 
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Preparing to play (Basic) 

Launching rekordbox 

Log on as the user which was set as the computer’s administrator before using rekordbox. 

For Mac OS X 

Open the [Application] folder with Finder, then double-click [rekordbox 3]. 

 

For Windows® 8.1, Windows® 8, Windows® 7 

Double-click the [rekordbox 3] icon (shortcut) on the desktop. 
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Adding music files to Collection 

Collection contains music files managed by rekordbox. 

Music files can be used in rekordbox only after analyzing the music files in the computer and 

creating a music collection for rekordbox. 

 

Adding music files to Collection 

1 Click [Collection] in the Tree View. 

Music files in [Collection] are displayed in the track list. 

2 Open Finder or Windows Explorer and drag and drop music files and/or folders, where 

music files are stored, to the track list. 

The music file is added to the collection, and its tag information is loaded and displayed. 

When analysis of the music file’s wave information begins,  is displayed to the left of 

the music file being analyzed, then turns off once analysis is completed. 

There is a choice of two modes for analyzing the waveform information of music files: 

[Normal] and [Dynamic]. 

 You can also add music files or folders by selecting [File] menu > [Import]. 

 When a WAVE file is added to Collection, its tag information may not be displayed. The 

tag information of music files that can be read is ID 3 tag (v1, v1.1, v2.2.0, v2.3.0, and 

v2.4.0) of MP3 and AIFF files, the meta tag of M4A files, and RIFF INFO of WAVE files. 

 Once analysis of the music file’s waveform information is completed, the beat positions 

and tempo (BPM) can be checked on the player panel. Also, a waveform is displayed in 

the Preview column of the Browser panel. 

 The key can be detected simultaneously while analyzing a music file’s waveform 

information  
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 To remove music files from the collection, select the music file at [Collection] then press 

the [Delete] key on the computer’s keyboard. The music file is removed from the 

collection, but the music file itself is not deleted from the computer. 

Editing the information on a music file 

1 Click [Collection] in the Tree View. 

Music files in [Collection] are displayed in the track list. 

2 Click . 

The [Information] pane is displayed on the right of the track list. 

3 Click a music file in [Collection]. 

The [Summary] tab is displayed in the [Information] pane. 

4 Click the [Info] tab in the [Information] pane. 

The [Info] tab is displayed in the [Information] pane. 

5 Edit the information. 

The information for the music file is changed. 

Adding an artwork image to a music file 

The artwork image formats which can be added to a music file are JPEG and PNG (extensions: 

“jpg”, “jpeg”, “png”). 

1 Click the [Artwork] tab in the [Information] pane. 

2 Open Finder/Windows Explorer. 

3 Drag an image file from Finder/Windows Explorer to the [Artwork] tab. 

The artwork image is added to the music file. 
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Reloading the tag information of a music file 

When an external application is used to modify the music file tag information, this tag information 

must be reloaded in rekordbox to properly display any changes. 

Click  on the upper right of [Info]. 

The tag information of a music file is reloaded. 

When a music file’s tag information is reloaded, the contents edited at the [Info] and [Artwork] 

tabs are replaced with the reloaded tag information. 

Referring to external library 

 Referring to iTunes library 

If iTunes is installed to your computer, iTunes library can be used on rekordbox. 

 

 If iTunes library is not shown, make the following settings. 

- Open [Preferences] > [View] and tick [iTunes] of [Treeview]. 

- Open [Preferences] > [Bridge] and specify a library file at [iTunes] section.  

 Click  on the right side of [iTunes] to update the [iTunes] library to the latest. 

 Adding music files from the iTunes library 

You can add iTunes music files to the rekordbox Collection and analyze them. 

1 Click  to the left of [iTunes] in the tree view; then, click [All Tracks]. 

A list of iTunes music files are shown in the track list. 

2 Drag the iTunes music files in the track list to [Collection]. 

1 The music files are added to [Collection]. 
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 Reloading the iTunes library information 

It is necessary to reload your updated iTunes library information in order for it to be reflected 

in rekordbox. 

1 Click [Collection] in the Tree View. 

Music files in [Collection] are displayed in the track list. 

2 Right-click the music file and select [Get Info from iTuens]. 

The iTunes library information is reloaded. 

When the iTunes library information is reloaded, information that has been edited under the 

[Information] pane’s [Info] tab is replaced with the reloaded information. 

 Referring to rekordbox xml 

If you import files written in rekordbox xml format, you can use rekordbox xml library. 

 

1 Select rekordbox xml. 

Open [Preferences] > [Bridge], click [Browse] for [Imported Library] at [rekordbox xml] section, 

and specify an xml file. 

2 Display rekordbox xml in the tree view. 

Open [Preferences] > [View] and tick [rekordbox xml] in [Layout]. 

rekordbox xml is shown in the tree view. 

 Adding music files from rekordbox xml 

1 Click  on the left side of [rekordbox xml] in the tree view and click [All Tracks]. 

A list of rekordbox xml music files are shown in the track list. 
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2 Drag the rekordbox xml music files in the track list to [Collection]. 

The music files are added to [Collection]. 

 Referring to folders and music files in your computer and external devices such as a 

USB flash drive 

1 Click  on the left side of [Explorer] in the tree view. 

Folders in your computer and external devices such as a USB flash drive are shown in the 

tree view. 

 If [Explorer] is not shown in the tree view, make the necessary settings in [View] > [Layout] 

of the [Preferences] window. 

2 Select a folder in [Explorer]. 

Music files in the selected folder are shown in the track list. 

 Adding music files in the computer 

1 Select a folder in [Explorer]. 

Music files in the folder is now shown in track list. 

 If [Explorer] is not shown in the tree view, make the necessary settings in [View] > [Layout] 

of the [Preferences] window. 

2 Drag the music files in the track list to [Collection]. 

The music files are added to [Collection]. 

  is shown for the music files imported to folders in [Explorer]. 
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Searching for music files 

Operate the browser panel to browse the music file information and search. 

 

 You can refine your search by creating tags for music files. 

 

Searching a music file with the category filter 

1 Click [Collection] in the Tree View. 

Music files in [Collection] are displayed in the track list. 

2 Click  at the top of the track list. 

The category columns ([Genre], [Artist] and [Album]) are displayed along the top of the track 

list. 

3 Select and click a category. 

Only the music files in the selected category are displayed on the track list. 

 

Searching for a music file using the search filter 

 

1 Click [Collection] in the Tree View. 

Music files in [Collection] are displayed in the track list. 

2 Click  on the left of the search filter. 

A list of the searchable columns (item names) is displayed. 

3 Select and click the column (item name) you want to search from the pop-up list. 
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4 Enter characters in the search filter with the computer keyboard. 

Only the music files including the character string you have input are displayed on the track 

list, with the columns selected in step 3 as the searching range. 

 This display status returns to as it was originally when characters that have been input are 

deleted or the  button is clicked. 

Sorting the information to search for music files 

 

1 Click [Collection] in the Tree View. 

Music files in [Collection] are displayed in the track list. 

2 Click the column header by which you want to reorder. 

The arrangement of music files is changed. 

 Each time you click, the arrangement toggles between ascending and descending orders. 

3 Input characters using the computer’s keyboard. 

The cursor moves to a music file starting with the character entered. 

 If you enter another character, the cursor moves to the first music file in alphabetical order 

beginning with the current character combination. 

Turning the display of column headers on and off and changing their order 

1 Click [Collection] in the Tree View. 

Music files in [Collection] are displayed in the track list. 

2 Right-click the column header (item name). 

A list of the displayable column names (item names) is displayed. 

3 From the pop-up list, select the column name (item name) whose display you want to 

switch and click. 

The display of the item switches on and off. 

4 Drag the column header (item name) left or right. 

The arrangement of the column is changed.  
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Listening to music files 

Play the music file in the player panel and check its beat and tempo (BPM). 

 

Playing a music file 

1 Drag and drop a music file to the player from the track list. 

The track is now loaded to the player. 

2 Click [ ]. 

Playback starts. 

 Jumping from the current position 

1 Click . 

The dropdown menu is shown to select how many beats to jump. 

2 Select the number of beats. 

How many beats or bars to jump is now selected by clicking . 
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3 Click . 

The current position is jumped. 

 When  is clicked during the LOOP status, not only the current position but also 

the LOOP IN points and LOOP OUT points are jumped. 

 Listening to music files directly on the browser panel 

Playing the music file by clicking the waveform in the [Preview] column 

Click the waveform in the [Preview] column to start the playback from the position you clicked. 

Click the stop button on the left of the waveform to stop the playback. 

 

When the playback begins in the [Preview] column while another track is played in the player 

panel, the playback in the player panel pauses. 

Playing a music file by clicking the artwork in the [Artwork] column 

Click the artwork in the [Artwork] column to start the playback from the beginning of the music 

file. 

 

 Move the mouse cursor out of the Artwork to stop the playback. 

Click on the Artwork during playback will skip ahead by 30 second increments. 
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When the playback begins in the [Artwork] column while another track is played in the player 

panel, the playback in the player panel pauses. 

 Triggering Play/Pause and CUE in the enlarged waveform 

Using the mouse on the enlarged waveform will trigger the same behavior as clicking the [ ] 

and [CUE] buttons. 

 

 Click anywhere within the enlarged waveform to trigger the same behavior as clicking on 

the [ ] button. 

 Right click anywhere within the enlarged waveform to trigger the same behavior as 

clicking the [CUE] button. 

Checking the beat (beat grid) 

1 Click  among  on the upper right of the screen. 

One player is shown in the Player panel. 

2 Drag the music file from the browser panel to the player panel. 

The music file is loaded into the player panel. 

3 Click [ ]. 

Playback starts. 

 The BPM display shows the tempo measured when the music file was added. 

 The enlarged waveform display shows the beat grid in a white line which is generated 

when the music file is added (beat grid). 

 On the enlarged waveform display, the beats at the beginning of measures are indicated 

on the beat grid as a red line every four beats from the start to the end of the track. 

 is displayed for music files added with old versions of rekordbox (1.x.x). When music files are 

reanalyzed using a new version of rekordbox (3.x.x), the  mark turns off. 
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Adjusting the beat grid 

The enlarged waveform displays the beat grid with white lines. The beat grid can be adjusted by 

the following procedure. 

 

1 Click [ ] during playback. 

Playback is paused. 

2 Drag the enlarged waveform display to the left or to the right. 

Adjust so that the beat matches the vertical white line at the center of the enlarged waveform 

display. 

3 Click [GRID]. 

Beat grid adjustment menu’s icons appear in the function panel. 

The white lines to show the beatgrids turn to blue lines, and then editing becomes possible. 

4 Click . 

The current position moves to the nearest beat position at the center of the waveform, which 

is a white vertical line. The entire beat grid is slid with this move. 

The beat at the center becomes the first beat of the measure and it is shown as a red line. 

 If you want to slide the beat grid beyond a specific position, click . With this 

operation, beat grid points occurring before the white vertical line are locked and only those 

beat grid points occurring after the white vertical line will slide. 

5 Click [GRID]. 

The beat grid adjustment menu closes. 
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 Other icons (beat grid adjustment menu) 

 

Moves the beat grid 1 msec to the left． 

 

Moves the beat grid 1 msec to the right. 

 

Reduces beat grid intervals by 1 msec. 

 

Expands beat grid intervals by 1 msec. 

 

Doubles the number of beats (BPM). (The length of each beat grid interval is reduced by 

half.) 

 

Cuts the number of beats (BPM) in half. (The length of each beat grid interval is doubled.)

 

Temporarily marks the base position for adjusting the beat grid points. Only the beat grid 

points after the mark slide based on the marked position. The beat grid points before the 

mark are displayed as white dots, the beat grid points that have slid after the mark are 

displayed as blue bars. 

Until the mark is canceled, operations performed with the beat grid adjustment menu are 

only reflected on the beat grid points displayed as blue bars after the mark. 

 

Cancels the temporarily marked position for adjusting the beat grid. When the mark is 

canceled, the beat grid points of the music file are all switched back to a blue bar display. 

Operations performed with the beat grid adjustment menu are reflected on all of the 

music file’s beat grid points. 

 

Undoes operations performed with the beat grid adjustment menu. 

 

Plays track with a metronome in synchronization with the beat grid. Switches the 

metronome sound on and off and the metronome’s volume (high, medium and low). 

 

Changes the length of each beat grid interval based on the number of beats (BPM) that is 

input. 

 

Click the [TAP] button to manually select BPM. 
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Re-detecting beat positions and re-measuring the tempo 

1 From the [File] menu, select [Preferences] to open the [Preferences] screen, then set 

the file analysis mode. 

There is a choice of two modes for analyzing the waveform information of music files: 

[Normal] and [Dynamic]. 

2 Right-click the music file whose beat positions you want to detect and whose tempo 

(BPM) you want to measure, then select [Analyze Track]. 

The waveform data of the music file is analyzed. The detected beat position and the 

measured tempo are saved on the computer. 

When music files are re-analyzed, the beat grid set at Adjusting the beat grid is overwritten with 

the beat grid newly analyzed with the [Analyze Track] function. 

Using beat grids (Quantize) 

When setting cues and loops on the player panel, the cue and loop points can easily be set on 

beat. 

1 Click [QUANTIZE] on the player panel. 

[QUANTIZE] lights on the player panel. 

2 Set cue or loop points 

 Playing a DJ player or DJ mixer using the quantize function 

The beat grids of music files detected and adjusted using rekordbox can be used with the 

quantize function when performing cue operations and playing loops on DJ players 

(e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus, CDJ-900, XDJ-AERO, XDJ-R1). 

Furthermore, if the DJ player (e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus, CDJ-900) 

and DJ mixer (e.g. DJM-2000nexus, DJM-2000, DJM-900nexus) are connected by LAN 

cable, the quantize function can be used while you generate effects. 

 For instructions on using the quantize function on DJ players and DJ mixers, see 

theOperating Instructions for each respective DJ unit. 
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Detecting the key 

Right-click the music file whose key you want to detect, then select [Detect Key]. 

The waveform data of the music file is analyzed. The detected key can be checked on the 

[Collection], [Information] pane, etc. 

The key can be detected simultaneously when adding music files to collections. 

 

  



44 
 

Setting cue or loop points 

Use this procedure to set points for cueing (cue points) and points for loop playback (loop in and 

loop out points). 

 

Setting cue points 

1 Click [ ] during playback. 

Playback is paused. 

2 Click [CUE]. 

The point at which playback is paused is set as the cue point. [CUE] lights. 

 To start playback from the Cue Point, click [ ]. 

 When a new Cue Point is set, the previously set Cue Point is deleted. 

 When a different music file is loaded into the player panel, the previously set cue point is 

canceled. It is also possible to save cue points you have set. 

Returning to Cue Point (Back Cue) 

Click [CUE] during playback. 

The track instantaneously returns to the set cue point, cues there, and the pause mode is set. 

[CUE] lights. 

 To start playback from the Cue Point, click [ ]. 

Checking Cue Point (Cue Point Sampler) 

After returning to the cue point, press and hold [CUE] (press the left mouse button and do 

not release). 

Playback starts from the cue point. 
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Playback continues while [CUE] is pressed. When released, playback returns to the cue point 

and the pause mode is set. 

Setting Cue Point during playback (Real Time Cue) 

Click [LOOP IN] during playback at the position where you want to set the Cue Point. 

The point playing when it is clicked is set as the cue point. 

When [QUANTIZE] on the player panel is clicked, this lights up. 

When a real time cue is set after turning on [QUANTIZE] on the player panel, the cue point is 

automatically set to the beat grid point nearest the point playing when [LOOP IN] is clicked. 

Starting loop playback 

1 Click [LOOP IN] during playback at the position (Loop In Point) where you want to start 

Loop playback. 

The point playing when it is clicked is set as the loop in point. 

 This operation is not necessary if you want to set the currently set cue point as the loop in 

point. 

2 Click [LOOP OUT] at the position (Loop Out Point) where you want to end Loop 

playback. 

The point playing when it is clicked is set as the loop out point, the track returns to the loop in 

point and loop playback starts. 

 When the Loop Point is newly set, the previously set Loop Point is deleted. 

 When a different music file is loaded into the player panel, the previously set loop points 

are canceled. It is also possible to save loop points you have set. 

When [QUANTIZE] on the player panel is clicked, this lights up. 

When a loop is set after turning on [QUANTIZE] on the player panel, the loop points are 

automatically set to the beat grid points nearest the points playing when [LOOP IN] and [LOOP 

OUT] are clicked. 
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Canceling Loop playback (Loop Exit) 

Click [EXIT] during Loop playback. 

When the loop out point is reached, playback does not return to the loop in point but continues 

normally. 

 

Resuming loop playback (Reloop) 

Click [RELOOP] during playback after Loop has already exited. 

Playback returns to the previously set loop in point and loop playback starts. 

 

Specifying the loop time in number of beats (Auto Beat Loop) 

You can play a loop with the loop length between 1/32 and 32 beats in accordance with 

the BPM of the playing music file. 

Click the number of beats as the loop length you want to play during playing a track. 

The point playing when the button is clicked is set as the loop in point and the loop out point is 

set according to the selected number of beats. 

 When an auto beat loop is set during loop playback, the current loop in point is maintained, 

and only the loop out point is moved. 

When [QUANTIZE] on the player panel is clicked, this lights up. 

When an auto beat loop is set after turning on [QUANTIZE] on the player panel, the loop points 

are automatically set to the beat grid points nearest the points playing when the selected beat 

length number is clicked. 
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Extracting loops and saving them as WAVE files 

To extract loops and save them as WAVE files, click  to the right of the enlarged waveform 

on the player panel while the loop is playing and select [Export Loop As Wav]. 

 Extracted loop elements are saved as WAVE files (48 kHz sampling frequency, 16-bit 

quantization) and added to the rekordbox music collection. The filename specified for the 

WAVE file when it was saved is displayed in the title column on [Collection]. 

 For instructions on using saved loop elements (WAVE files), see the operating instructions of 

the respective DJ unit (e.g. RMX-1000, XDJ-AERO). 
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Saving cues or loops 

Cue and loop points you have set can be saved and called later. Up to 10 cue or loop points can 

be saved per music file. 

Saved cue and loop points can be called out and played on the DJ player 

(e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus, CDJ-900, CDJ-850, MEP-4000). 

 

Saving cue or loop points you have set 

1 Set Cue Point or Loop Point. 

2 Click [MEMORY]. 

 

The saved Cue / Loop points in (minute:second:milliseccond) are shown in the sub-panel for 

the loaded track. 

 Click [MEMORY] during Loop playback to save a Loop Point. The Loop points in 

(minute:second:millisecond) are shown in the sub-panel for the loaded track. 
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Calling saved cue or loop points 

1 Load the music file containing the cue or loop points you want to call into the player 

panel. 

The saved Cue/Loop points in (minute:second:millisecond) are shown in theMEMORY panel 

in the sub-panel for the loaded track. 

2 Click the Cue/Loop Call button to start playback from the set Cue/Loop point. 

 

The playback position is moved to the selected point and paused. 

 Click  to jump to a saved cue or loop point after the currently playing position. 

 Click  to jump to a saved cue or loop point before the currently playing position. 

3 Click [ ]. 

Playback or loop playback starts. 

 To delete the already saved Cue Point or Loop Point, click [ ] on the right side of 

the Cue/Loop Call button whose cue/loop point you want to delete. 

 Setting a saved loop as the active loop 

When a loop point is saved, a loop icon  is displayed on the left side of Cue/Loop Call 

button. 

To set the saved loop as the active loop, click . 

When a loop is set as the active loop,  is shown. 

 For instructions on using active loops, see the operating instructions of the respective DJ 

player (e.g. CDJ-2000nexus). 
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 Adding comments to saved cue and loop points 

Your comment can be added in the column on the right side of the Cue/Loop Call button in the 

sub-panel for the loaded track. 

Click the Comment column to enter your comment using the keyboard of your computer. Then, 

press [Enter]. 

 

 Changing colors of cue markers displayed above the waveform 

 

The color of the cue markers displayed above the waveform can be changed. 

Right-click the comment column to the right of Cue/Loop Call button in the sub-panel for the 

loaded track and select a color in the Color dropdown menu. 

 Comments and colors added to cues cannot be exported to a device. 
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Storing hot cues 

When cue and loop points are stored as hot cues, they can be played instantaneously. Up to 

three hot cues can be set per music file. 

Saved hot cues can be called out and played on the DJ player 

(e.g. CDJ-2000nexus, CDJ-2000, XDJ-R1). 

 

Storing cue or loop points as hot cues 

In the play or pause mode, click one of the [HOT CUE] buttons (A, B or C) at the position 

you want to store as a hot cue. 

The point playing (or paused) when the button was clicked is stored as a hot cue. Stored 

points are displayed at [HOT CUE]. 

 When a [HOT CUE] button is clicked during loop playback, the currently playing loop point 

is stored as the hot cue. 

The stored hot cue points in (minute:second:millisecond) are shown in the sub-panel for the 

loaded track. 

When [QUANTIZE] on the player panel is clicked, this lights up. 

When a hot cue is set after turning on [QUANTIZE] on the player panel, the hot cue point is 

automatically set to the beat grid point nearest the point playing when [HOT CUE] is clicked. 
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Calling and playing stored hot cues 

Click the Hot Cue Call button. 

Playback starts instantaneously from the point recorded in the button. 

 

 To delete a stored point, click [ ]. 

Calling already saved cue or loop points and storing them as hot cues 

1 Load the music file containing the saved cue or loop points into the player panel. 

The Cue Point or Loop Point is displayed in the Cue/Loop Call button. 

2 Click the Cue/Loop Call button you want to set as a hot cue. 

The playback position is moved to the selected point and paused. 

3 Click the [HOT CUE] button (A, B or C) at which you want to store the hot cue. 

The recorded position is displayed in [HOT CUE]. 
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Adding commnets to hot cues 

You can add your comment in the Comment column of the HOT CUE panel in the sub-panel for 

the loaded track. 

Click the Comment column to enter your comment using the keyboard of your computer. Then, 

press [Enter]. 

 The comment added to a hot cue cannot be exported to a device. 
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Organizing music files by using Playlist 

You can organize the music collection on rekordbox by creating a Playlist prior to performance. 

 

Creating a new playlist 

1 Click  on the right side of a playlist or playlist folder. 

New playlist ([Untitled Playlist]) is added under [Playlists]. 

2 Input the playlist’s name from the computer’s keyboard, then press the [Enter] key. 

The name of Playlist is changed. 

3 Click [Collection] in the Tree View. 

Music files in [Collection] are displayed in the track list. 
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4 Drag a music file to the playlist you have created in the above to the tree view. 

The music file is added to Playlist. 

 Music files can also be added to Playlist by dragging them from [iTunes], [Tag List] or other 

playlists. 

 To delete a playlist, select the playlist then press the [Delete] key on the computer’s 

keyboard. 

 To remove a music file from a playlist, select the music file then press the [Delete] key on 

the computer’s keyboard. 

Adding Playlist by importing an external file 

The playlist file formats which can be imported are M3U and M3U8 (extensions : “m3u”, “m3u8”). 

1 Select [File] menu > [Import] > [Import Playlist]. 

The [Import Playlist] screen opens. 

2 Select the folder in which the playlist file is stored or the file name, then click [Open]. 

The playlist is added to [Playlists]. 

The tag information for the music files in the playlist is loaded and displayed, and analysis of 

the music files begins. 

Referring to external library 

 Referring to iTunes library 

If iTunes is installed to your computer, iTunes library can be used on rekordbox. 

 

 If iTunes library is not shown, make the following settings. 

- Open [Preferences] > [View] and tick [iTunes] of [Treeview]. 

- Open [Preferences] > [Bridge] and specify a library file at [iTunes] section. 

 Click  on the right side of [iTunes] to update the [iTunes] library to the latest. 
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 Adding a playlist from the iTunes library 

Playlists can be created in rekordbox by importing them from iTunes library. 

1 Click  on the left side of [iTunes] in the tree view and click  on the left side of 

[Playlists]. 

A list of iTunes Playlist is shown in the tree view. 

2 Drag an iTunes playlist to [Playlists] layer or below. 

The music files are added to [Collection]. 

The iTunes playlist is added to rekordbox playlists. 

 Referring to rekordbox xml 

If you import files written in rekordbox xml format, you can use rekordbox xml library. 

 

1 Select rekordbox xml. 

Open [Preferences] > [Bridge], click [Browse] for [Imported Library] at [rekordbox xml] section, 

and specify an xml file. 

2 Display rekordbox xml in the tree view. 

Open [Preferences] > [View] and tick [rekordbox xml] in [Layout]. 

rekordbox xml is shown in the tree view. 

  



57 
 

 Adding a playlist from rekordbox xml 

You can import playlists in rekordbox xml library to rekordbox and add them to playlist. 

1 Click  on the left side of [rekordbox xml] in the tree view and click  on the left side 

of [Playlists]. 

A list of rekordbox xml playlist is shown in the tree view. 

2 Drag rekordbox xml playlist to [Playlists] layer or below. 

rekordbox xml playlist is added to [Playlists]. 

 Referring to folders and music files in your computer and external devices such as a 

USB flash drive 

Click  on the left side of [Explorer] in the tree view. 

Folders in your computer and external devices such as a USB flash drive are shown in the 

tree view. 

 If [Explorer] is not shown in the tree view, make the necessary settings in [View] > [Layout] 

of the [Preferences] window. 

 Adding a folder stored in the computer and an external device, such as a USB flash 

drive, as a playlist 

Drag a folder in [Explorer] to [Playlists] in the tree view. 

A playlist is created with the name of the folder. 
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Organizing Hot Cue by using Hot Cue Bank List 

  

The cue/loop point information for different music files can be stored in three hot cue banks. The 

combination of the three hot cue banks (A, B, C) is called the hot cue bank list. 

Rotating between multiple hot cue bank lists will allow you to raise the bar on your DJing quality 

by improving your range of cue performance. 

 Hot cue bank lists cannot be loaded onto some DJ players 

(e.g. CDJ-900nexus, CDJ-900, CDJ-850, CDJ-350, MEP-4000, XDJ-AERO, XDJ-R1). 

 When 2 Player mode is selected in the player panel, Hot cue bank buttons and the delete 

buttons are disabled. 

 

Creating a new hot cue bank list 

1 Click  to the right of the [Hot Cue Bank Lists] folder. 

[Untitled Hot Cue Bank List] is added under the [Hot Cue Bank Lists] folder. 

2 Input the list’s name from the computer’s keyboard, then press the [Enter] key. 

The name of Hot Cue Bank List is changed. 

 To delete a hot cue bank list, select the hot cue bank list then press the [Delete] key on the 

computer’s keyboard. 

Registering cue and loop points in a hot cue bank 

In the play or pause mode, click one of the Hot Cue Bank buttons (A, B or C) at the 

position you want to register in the hot cue bank. 

The point being played (or paused) when the button is clicked is registered as a Hot Cue 

Bank. The registered point is displayed beside the Hot Cue Bank button. 

 When a Hot Cue Bank button is clicked during loop playback, the currently playing loop 

points will be registered as a Hot Cue Bank. 
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Checking registered hot cue banks 

Click the Hot Cue Bank button on which the registered point is displayed. 

The music file associated with the cue/loop point referenced by the button is loaded into the 

player panel, and playback starts from the registered point. 

 To delete a registered cue/loop point, click [ ] on the right side of the Hot Cue 

Bank button whose cue/loop point you want to delete. 

Calling already saved cue or loop points and registering them in a hot cue bank 

1 Load the music file containing the saved cue or loop points into the player panel. 

The Cue Point or Loop In Point is displayed in the Cue/Loop Call button. 

2 Click the Cue/Loop Call button you want to register in a hot cue bank. 

The playback position is moved to the selected point and paused. 

3 Click the Hot Cue Bank button (A, B or C) at which you want to register the cue/loop 

point. 

The registered cue/loop point is displayed beside the Hot Cue Bank button. 

Calling already stored hot cues and registering them in a hot cue bank 

1 Load the music file for which the hot cues are stored into the player panel. 

The stored point is displayed in [HOT CUE]. 

2 Click [ ] if a music file is being played back. 

Playback is paused. 

3 Click the [HOT CUE] you want to register in a hot cue bank. 

The playback position is moved to the selected point and paused. 
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4 Click the Hot Cue Bank button (A, B or C) at which you want to register the cue/loop 

point. 

The registered cue/loop point is displayed beside the Hot Cue Bank button. 

Organizing Hot Cue Bank List by using a folder 

1 Right-click the [Hot Cue Bank Lists] folder and select [Create New Folder]. 

[Untitled Folder] is added under the [Hot Cue Bank Lists] folder. 

2 Input the folder’s name from the computer’s keyboard, then press the [Enter] key. 

3 Drag Hot Cue Bank List to the newly created folder. 

Hot Cue Bank List is moved under the newly created folder. 

 To delete a folder, select the folder then press the [Delete] key on the computer’s keyboard. 

All hot cue bank lists and folders contained in that folder are deleted. 

Adding an artwork image to Hot Cue Bank List 

The artwork image file formats which can be added are JPEG or PNG (extensions: “jpg”, “jpeg”, 

“png”). 

1 Right-click Hot Cue Bank List and select [Add Artwork]. 

The [Add Artwork] screen opens. 

2 Select the folder in which the image file is stored and the file name, then click [Open]. 

The artwork image is added to Hot Cue Bank List. 

 Artwork images that have been added are displayed when the hot cue bank list is 

right-clicked. 
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Preparing to play (Advanced) 

Facilitating the preparation using many useful functions 

This section provides how to efficiently use many useful functions to facilitate the preparation. 

A shortcut instantly navigates you in the tree view 

If you create a shortcut of a folder or a playlist in the tree view and click it, the folder or the playlist 

is shown and highlighted instantly. 

 Up to 8 shortcuts can be created there. 

 The shortcut is not shown as dafault. 
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1 Click  in the tree view. 

 

The shortcut column appears. 

2 Drag a folder or a playlist in the tree view to an empty field of the shortcut column. 

 

A shortcut for a folder or a playlist is created there. 

 If you drag a folder or a playlist to an already created shortcut, the shortcut is overwritten 

with the newly dragged one. 
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3 Click a shortcut you have created. 

The applicable folder or playlist in the tree view is instantly displayed and highlighted. 

 If a shortcut is dragged upward or downward and dropped, the order of the shortcuts can 

be arranged. 

 Right click the shortcut and select [Delete shortcut] to remove the shortcut. (Even if the 

shortcut is removed, the original folder or playlist will not be deleted.) 

 If you drag a track to the playlist shortcut, the track can be added to the playlist. 

Classifying music files using the playlist palette 

You will efficiently categorize and select tracks using the playlist palette. 

 When you assign a playlist to a section of the palette, 4 lists are displayed simultaneously and 

the playlist can be edited there. 

 The playlists in the palette will remain as they are even after quitting rekordbox. 

 

 Selecting a palette 

 

3 palettes on the right among the 4 palettes are the playlist palettes. 

The far left palette  is used as TAG LIST. 

 

Click  . 

Four playlists in the selected palette are displayed. 

Click  to open and close a list in the palette. 
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 Assigning a playlist to a list of the palette 

Drag a playlist in the tree view to a list of the palette. 

The playlist is assigned to the palette. 

 The previously assigned playlist will be overwritten with the newly assigned playlist. 

 

 Adding tracks to the palette 

Drag a track in the track list to a section of the palette. 

The track is added to a playlist in the palette. 

When a track is dragged to [blank list], [Untitled Playlist] is shown. 

Type the playlist name on your computer keyboard. 

Now, a new playlist is added to [Playlists]. 

 Double click the playlist name on the palette to edit the playlist name. 
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 Adding a track in the palette 

Drag a track in the playlist of the palette to another playlist. 

 A track in one of the palette playlists can be added by dragging it to another playlist. 

 

 Loading a track in the palette 

Drag a track in the palette and drop it in the player panel. 

The track in the palette is loaded to the player. 

 Sorting tracks in the palette 

1 Click  on the right side of the list name. 

A dropdown menu appears. 

2 Move the cursor on [Sort] and select a criteria you want to sort by. 

 

Tracks are sorted in the order of the criteria you selected. 

  is shown on the right side of the playlist name during sorting. 

3 Click . 

You can toggle between ascending and descending order. 

  shows the list in ascending order and  in descending order. 
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 Changing the order of tracks in the palette 

Drag a track upward or downward to move the track within a playlist of the palette. 

The order of tracks in the palette can be changed. 

 This method is available only when the tracks are sorted by track number. 

 Removing a playlist from the palette 

1 Click  on the right side of the list name. 

A dropdown menu appears. 

2 Click [Remove from Palette]. 

The playlist is removed from the palette. 

 

 Changing the order of the playlist in palette 

Drag and drop the playlist name of the Palette to another playlist in the Palette. 

The order of the 4 lists in the palette can be arranged. 

 

 Showing and highlighting the playlist in the tree view 

Click a playlist name of the palette. 

The applicable playlist is instantly displayed and highlighted. 
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Organizing music files using an intelligent playlist 

You can automatically create a list of music files by narrowing down the search using filters. 

 Creating an intelligent playlist 

1 Right click in [Playlists] and select [Create New Intelligent Playlist] in the dropdown 

menu. 

 

The Setup window for the intelligent playlist opens. 

2 Select the filters to narrow down the search. 

 

 Select a filter. 

 Select how to narrow down your search. 

 [=] : Music files which fully match the text or value you entered are shown in the list. 

 [≠] : Music files which do not match the text or value you entered are shown in the list. 

 [&gt;] : Music files whose value is larger than the one you enterd are shown in the list. 

 [&lt;] : Music files whose value is smaller than the one you entered are shown in the list. 

 [contains] : Music files which contain the text you entered are shown in the list. 

 [does not contain] : Music files which do not contain the text you entered are shown in the 

list. 
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 [starts with] : Music files which start with the text you entered are shown in the list. 

 [ends with] : Music files which end with the text you entered are shown in the list. 

 [is in the range] : Music files whose value is in the range of the 2 values you entered are 

shown in the list. 

 [is in the last] : Music files whose date is within the days or months ago from the current 

date you entered are shown in the list. 

 [is not in the last] : Music files whose date is not within the days or months ago from the 

current date you entered are shown in the list. 

 You can customize your search depending on filters. 

Enter a text or a value using your computer keyboard if the dropdown menu is not shown. 

 Click the [+] button to add a filter. 

A new filter is added. 

Click to select [Match all of the following conditions] or [Match any of the following conditions] 

filters. 

 Delete a filter. 

Click the [-] button to delete a filter which you do not need. 

 Type in the name of the intelligent playlist. 

Type the text using your computer keyboard. 

 Click [OK] or [Cancel] to confirm or cancel the filters. 

3 Click the [OK] button. 

A narrowed down Intelligent Playlist is added below [Playlists] in the tree view folder. 

 

 Right click the intelligent Playlist in the tree view and select [Edit the Intelligent Playlist] to 

show and edit the filters to narrow down the search. 

 Right click an Intelligent Playlist in the tree view and select [Delete Playlist] to delete it. You 

can also delete an Intelligent Playlist by pressing the [Delete] key on your computer after 

selecting the Intelligent Playlist. 
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Customized browsing using My Tag 

You can refine your search by creating tags for music files. 

Customized browsing can be achieved by creating tags as you wish by defining the tracks’ 

features and occasions where tracks are to be used. 

 User-defined My Tag can be attached to a music file selected in the track list. 

 My Tag attached to music files are shown in the My Tag column. 

 My Tag filter allows you to refine your search using tags of My Tag as search criteria. 

 

 Editing My Tag 

1 Click  on the right edge of the screen. 

My Tag dropdown menu is shown on the right side of the track list. 

 

 Category : You can add category names you want. 

 My Tag has 4 categories and the category names can be changed as you want. 

 My Tag: You can attach tags to music files and the tag names can be changed as you want. 
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 My Tag checkbox: Tick this checkbox to attach or remove a tag to the music file selected in 

the track list. 

 Create a new tag button: Click this button to create a new tag to My Tag. 

2 Changing the category name 

Click a category name and type letters on your computer keyboard. Then, press the [Enter] 

key. 

The name of the category is changed. 

3 Changing the tag name 

Click a tag for My Tag and type letters on your computer keyboard. Then, press the [Enter] 

key. 

The name of the tag is changed. 

 Attaching My Tag to a music file 

1 Click a music file where you want to attach My Tag among the music files in the track 

list. 

The selected music file is highlighted. 

2 Tick the checkbox before the tag you want to attach. 

The ticked tag is attached to the music file. Tick other tags’ checkboxes if you want to attach 

them. 

 Open [Preferences] > [Advanced] and tick a checkbox of [Add “My Tag” to the 

“Comments”] to show My Tag in the Comments column of the track list. 
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 Refining search using My Tag 

 

1 Click  on the left side of the search filter. 

My Tag filter is displayed. 

2 Select BPM. 

Music files whose BPM is within the selected BPM range are displayed in the track list. 

3 Click a tag for My Tag you want to search. 

Only the music files where the selected tags for My Tag is attached are displayed in the track 

list. 

 Multiple tags can be selected. 

When multiple tags are selected, the music files containing all the selected tags are 

displayed in the track list. 

 Click [RST] to cancel all the tags selected in the My Tag filter. 

 Deleting My Tag 

1 Click  on the right edge of the screen. 

My Tag dropdown menu is shown on the right side of the track list. 

2 Right click a tag for [My tag] and click [Delete]. 

The tag for [My tag] is deleted. 
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Suggesting the next track to be played 

Suggested tracks to be played next are automatically listed based on how they are related with 

the current track. The suggested tracks are listed based on the track information such as BPM, 

Key, Color, Rating and My Tag. 

You can manually select a good match combination in the 2 Player mode and this combination is 

saved and displayed. 

1 Click . 

The [Related Tracks] pane is displayed. 

 

2 Click . 

The window to customize the criteria pops up. 

3 Select criteria to specify how tracks are suggested. 
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Current track: 

Player A: List tracks suggested to be played next to the track loaded to [Player A]. 

Player B: List tracks suggested to be played next to the track loaded to [Player B]. 

List: List tracks suggested to be played next to the track selected in the track list window. 

Criteria: 

BPM/Key, etc.: Tracks are suggested using track information such as BPM and key which 

are similar to the current track. 

History: Tracks are suggested from the playback history on CDJ stored in rekordbox. 

Matching: Tracks are suggested among the tracks you manually selected by 

clicking  icon as a good match combination for mixing in 2 Player mode. 

Please see for details of how to manually select tracks as a good match combination for 

mixing. 

When [BPM/Key, etc.] are selected, the following parameters can be selected. 

Range of BPM: Select within 0 %–30 % from the current track. 

Key: Select among [Same key], [Related key 1] and [Related key 2]. 

Tracks recently added: Enter how many days ago (within 180 days). 

Tracks in the same genre: Select the tracks in the same genre. 

Tracks with the same color: Select the tracks with the same color. 

Rating: Tracks with the ratings above you specified are shown. 

My Tag: Select [Match all of the items] or [Match any of the items]. 

4 Select the criteria and click [OK]. 

The selected criteria is now effective. 
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Using 2 Player mode to prepare for mixing tracks 

You can preview whether the mixed 2 tracks are matched as well as adjust Beat Grid of each 

track. 

A good match combination of tracks can be saved in the library and shown as a good match later 

when selecting tracks. 

 

Mixing 2 tracks in both Player A and Player B 

1 Click  at the top right of the screen. 

The player panel is switched to 2 Player mode. 

2 Drag a music file in the track list , etc. to Player A. 

A music file is now loaded to Player A. 

3 Drag a music file in the track list, etc. to Player B. 

A music file is now loaded to Player B. 

4 Click [ ] on Player A and Player B. 

Tracks in Player A and Player B start playback. 
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5 Adjusting the mixing audio volume of Player A and Player B. 

You can preview a mix using the Crossfader. 

If you move the Crossfader toward Player A, the volume of Player A becomes louder and 

Player B does smaller. In contrast, if you move the Crossfader toward Player B, the volume of 

Player B becomes louder and Player A does smaller. 

 

Displaying the function panel 

Click  on the left side of the player, and the Function panel will appear, and you can 

perform detailed operations including saving Cue points, playing Loops and adjusting the beat 

positions. Click  again, and the Function panel will be hidden. 

 

 

Adjusting the playback speed of the music file (Tempo control) 

Playback speed of two music files can be adjusted. 

 

Click the TEMPO adjustment button. 

You can change the playback speed of the music file playing. 

 Click , and the playback speed will become faster. 

 Click , and the playback speed will become slower. 

 Click [RST], and the playback speed will return to the original speed. 

 Click the BPM field to directly type the BPM values there. 
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Adjusting the playing speed without changing the pitch (Master Tempo) 

1 Click [MT]. 

Mater tempo is activated now. 

2 Click the TEMPO adjustment button. 

 Even if you change the playback speed, the key will not change. 

The audio quality may be affected because the audio signal is digitally processed. 

 

Adjusting the beat positions of two tracks manually using Pitch Bend 

Click  or  during playback. 

 Click  while playing a track, and the playback speed continues slowing down as long 

as it is pressed. 

 Click  while playing a track, and the playback speed continues speeding up as long 

as it is pressed. 

 

Synchronizing the beat positions and tempo of two tracks using Beat Sync 

1 Play a track on Player A. 

The Player which first begins the playback becomes the Sync Master. 

2 Play a track on Player B. 

3 Click [SYNC] on Player B. 

The Tempo (BPM) and beat positions of the track on Player B will be synchronized with those 

on Player A. 

 Click [SYNC] again, the SYNC function will turn off. 
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 To get back to the original BPM on each player after turning the SYNC feature off, Click 

[RST]. 

 

Setting two tracks as a good match combination 

If the two tracks are found a good match to mix because of harmonious combination and other 

reasons, such information can be stored in the library. 

The stored information can be shown as a good match combination when selecting tracks later. 

Click . 

The icon changes to , and the two tracks are stored as a good match combination to mix 

in the library. 

 If music files loaded to Player A and Player B are set as a good match combination,  is 

automatically shown. 
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Synchronizing iTunes library and devices 
withrekordbox using Sync Manager 

Sync Manager will allow you to export playlists in iTunes and rekordbox to USB devices in an 

updated status. 

Synchronizing with iTunes library 

Once iTunes library is synchronized, information in iTunes library can be used seamlessly 

on rekordbox. 

The synchronized iTunes playlists are updated and shown in [iTunes] in the tree view. 

Tracks in the synchronized playlists are automatically analyzed by rekordbox, and their artwork 

and waveform will be shown. 

Synchronizing with a device 

When a device is synchronized, the playlists you selected are exported to the device with the 

updated information. 

Cues, beat positions and ratings updated on a DJ player also can be imported back torekordbox. 

 

Launching Sync Manager 

Click  at the bottom of the tree view, and Sync Manager will launch. 
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Selecting iTunes playlists to synchronize with rekordbox 

 

1 Tick the checkbox of [Synchronize iTunes playlists]. 

You can select iTunes folders or playlists to synchronize with rekordbox. 

2 Tick the checkboxes on the right side of iTunes folders or playlists. 

3 Click  on the right side of iTunes playlists. 

The ticked playlist is synchronized with rekordbox. 

When the synchronization is successfully completed, the synchronized playlists appear in the 

tree view of rekordbox of Sync Manager. 

 

  



80 
 

Synchronizing playlists in rekordbox or those in iTunes with a device 

 

1 Insert a USB device or an SD card to your computer. 

2 Click  to select a device from the dropdown menu. 

Playlists in the device you selected are now displayed. 

3 Tick the checkbox for [Synchronize playlists with a device]. 

You can select rekordbox folders or playlists to synchronize with the device. 

4 Tick the checkboxes on the right side of rekordbox folders or playlists to synchronize 

with the device. 
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5 Click  on the left side of the [Device]. 

The ticked playlist is synchronized with rekordbox. 

When a device is synchronized, the playlists you selected are exported to the device with the 

updated information. 

Track information of tracks in the playlists is also updated. 

 

Importing Cues, beat positions and ratings updated in a DJ player back 

torekordbox 

1 Connect a device which is synchronized with rekordbox to your computer and launch 

Sync Manager. 

2 Click  to select a device from the dropdown menu. 

3 Click  on the left side of [Device]. 

Information in the device is imported to rekordbox. 

The same results are expected if you select a device in the tree view and select [Update 

Collection]. 

Neither the information of tracks exported from a different computer nor that of tracks deleted 

from the Collection can be imported. 
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Playback using DJ units 

Playback with a USB device 

         

You can deliver music files and their related data saved with rekordbox to your DJ player by 

using USB devices (flash memory or hard disk) without the hassle of bringing your computer to 

the DJ booth. 

 For music files (file formats) that can be loaded and played on Pioneer DJ players, see 

the Operating Instructions for each respective DJ player. 

 In addition to USB devices, SD memory cards can be used for some DJ players (e.g. 

CDJ-2000nexus or CDJ-2000). 

 Hot cue bank lists cannot be loaded onto some DJ players 

(e.g. CDJ-900nexus, CDJ-900, CDJ-850, CDJ-350, MEP-4000, XDJ-AERO, XDJ-R1). 
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Connecting the USB device to the computer 

1 Plug the USB device into the computer. 

 With some DJ players (e.g. CDJ-2000nexus or CDJ-2000), SD memory cards can be used 

instead of USB devices. 

2 Click  for the USB device you want to use for the performance. 

The USB device’s settings are displayed in [Devices]. 

 Connecting mobile devices supporting wireless LAN (Wi-Fi®) 

On [Devices], rekordbox music files can be transferred not only to USB devices and SD 

memory cards, but also to mobile devices (e.g. iPhone, Android™ devices) that support 

wireless LANs (Wi-Fi®). 

First set the mobile version of rekordbox on the mobile device to the communications standby 

mode, then click  on the right of [Devices]. 

When the mobile devices in the computer’s area are detected and the links are established, 

the names of the mobile devices are displayed on [Devices]. 

 Details on functions that can be used in association with rekordbox on mobile devices and 

their operating instructions are provided on the rekordbox online support site. 
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 USB device settings 

The settings can be changed for individual USB devices. 

General 

Device Name 
Sets the name to be displayed when the device is con-

nected to the DJ player. 

Background 

Color 

Sets the background color to be displayed when the device 

is connected to the DJ player. 

Category 

Specifies the category items to be used with the DJ player and the order in 

which they are displayed. For more instructions on using a DJ player’s Library 

Browse function, see the Operating Instructions for each respective DJ player.

Sort 

Specifies the sorting items to be used with the DJ player and the order in 

which they are displayed. For more instructions on using a DJ player’s Library 

Browse function, see the Operating Instructions for each respective DJ player.

Column 

Specifies a user-set category to be displayed to the immediate right of titles 

when browsing music files on the main unit display of the DJ player 

(e.g. CDJ-2000nexus). 

Color 

Comments on the color codes used for classifying the categories of music files 

on DJ players in eight colors can be edited. For more instructions on using a 

DJ player’s Library Browse function, see the Operating Instructions for each 

respective DJ player. 

Transferring music files to USB devices 

1 Click  to the left of the  to where you want to transfer the music file, and then click 

[All Tracks]. 

2 Drag a music file from [Collection] to a device icon in [Devices]. 

The music file and the information associated with it are transferred to the USB device. 

 Music files can also be transferred by dragging them from [iTunes] and [Explorer] to a 

device icon in [Devices]. 

 To delete the music file from the USB device, select the music file in [Devices], then press 

the [Delete] key on the computer’s keyboard. (The music files while they are transferred 

cannot be deleted.) 
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- The progress bar appears at the bottom of the screen while the device is transferred. 

- The music files can be transferred to multiple devices at the same time. 

For some DJ players (e.g. MEP-4000, XDJ-R1) it is necessary not only to transfer the music 

files to the USB device, but also to create a special library (a database for collections, 

playlists, etc.) on the USB device. 

 Playing a DJ player or DJ mixer using the quantize function 

The beat grids of music files detected and adjusted using rekordbox can be used with the 

quantize function when performing cue operations and playing loops on DJ players 

(e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus, CDJ-900, XDJ-AERO, XDJ-R1). Furthermore, 

if the DJ player (e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus, CDJ-900) and DJ mixer 

(e.g. DJM-2000nexus, DJM-2000, DJM-900nexus) are connected by LAN cable, the quantize 

function can be used while you generate effects. 

 For instructions on using the quantize function on DJ players and DJ mixers, see the 

Operating Instructions for each respective DJ unit. 

 Using the beat sync function between multiple DJ players for playback 

When the beat grids of music files detected and adjusted using rekordbox are used, the sound 

can be mixed synchronizing the tempos (BPM) and beats of multiple DJ players 

(e.g. CDJ-2000nexus, CDJ-900nexus) connected by PRO DJ LINK or of the left and right decks 

(e.g. XDJ-AERO, XDJ-R1). 

 For instructions on using the beat sync function on DJ players, see the operating instructions 

of the respective DJ players. 

 Playing back on a DJ player by using hot cues 

The hot cues (A, B and C) stored for music files can be called out on DJ players (e.g. 

CDJ-2000nexus, CDJ-2000 or XDJ-R1) and played. 

 For instructions on using the hot cues (A, B and C) stored for music files on DJ players, see 

the respective DJ players’ operating instructions. 

 For some DJ players (e.g. CDJ-2000nexus, XDJ-R1), when a music file is selected and 

loaded onto the DJ player, the hot cues (A, B and C) stored for the music file can be 

simultaneously loaded, forcibly replacing the DJ player’s hot cues (A, B andC). 

 To use combinations of hot cues (A, B and C) of different music files for playback, a hot cue 

bank list must be created and transferred to a USB device. 



86 
 

Transferring playlists to USB devices 

1 Click  to the left of the  to where you want to transfer the playlist, and then 

click  to the left of the [Playlists] folder. 

2 Drag a playlist to [Devices]. 

The playlist and the music files contained in it are transferred to the USB device. 

 A playlist can be transferred by dragging it from [iTunes] to [Devices]. 

 To delete the playlist from the USB device, select the playlit in [Devices], then press the 

[Delete] key on the computer’s keyboard. 

Depending on the DJ player to which the USB device is connected for playback, there may 

be restrictions on the names of playlists and the folder structure on the USB device. For the 

restrictions that may apply when connecting USB devices for playback, see the operating 

instructions of the respective DJ player (e.g. MEP-4000, XDJ-R1). 

Transferring hot cue bank lists to USB devices 

  

To use combinations of hot cues (A, B and C) of different music files for playback, a hot cue 

bank list must be created ahead of time. 

1 Click  to the left of the  to where you want to transfer the hot cue bank list, and 

then click  to the left of the [Hot Cue Bank Lists] folder. 

2 Drag the hot cue bank list to [Devices]. 

The hot cue bank list and the music files contained in it are transferred to the USB device. 

 To delete the hot cue bank list from the USB device, select the hot cue bank list in 

[Devices], then press the [Delete] key on the computer’s keyboard. 
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Disconnecting USB devices from the computer 

1 Click  to the right of the  icon, if you want to disconnect from the computer. 

2 Disconnect the USB device from the computer. 

 The USB device cannot be disconnected while the data is transferring. If you want to 

disconnect the device, click  to the right of the progress bar to cancel the data transfer. 

When [Create library exclusively for] is set at the [Preferences] screen,  is displayed 

at  to the right of . When  is clicked, creation of a library exclusively for 

the MEP-4000 or XDJ-R1 begins. Wait until this finishes before disconnecting the USB 

device from the computer. 

Playback by connecting a USB device to a DJ player 

A USB device (flash memory or hard disk) can be taken into the DJ booth to transfer music files 

and their related data saved on rekordbox to your DJ player. 

 In addition to USB devices, SD memory cards can be used for some DJ players (e.g. 

CDJ-2000nexus or CDJ-2000). 

 Hot cue bank lists cannot be loaded onto some DJ players 

(e.g. CDJ-900, CDJ-850,CDJ-350, MEP-4000, XDJ-AERO, XDJ-R1). 

 For some DJ players (e.g. MEP-4000, XDJ-R1), there are restrictions to displaying the folders 

and playlists on the USB device. 

 For instructions on connecting USB devices to DJ players and using the USB device for 

playback, see the Operating Instructions for each respective DJ player. 

Saving the history of playback on the DJ players 

     

Connect the USB device that was used for playback on the DJ player to the computer. 

The playback history in the device is automatically saved in rekordbox. 

The saved playback history is displayed in the [Histories] folder where the saved date is 

added. 

 The saved playback history is deleted from the USB device. 
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 When [Import the play history automatically] is disabled in the Preferences: 

1 Open the [Histories] folder in the USB device. 

A list of DJ player’s playback histories is displayed. 

2 Right-click the playback history you want to save and select [Import History]. 

The selected playback history is saved in rekordbox. 

The saved playback history is displayed in the [Histories] folder where the saved date is 

added. 

 The saved playback history is deleted from the USB device. 

Updating the collection for music file information modified on a DJ player 

      

1 Connect the USB device that was used for playback on the DJ player to the computer. 

2 Right-click on the USB device from which you want to import information and select 

[Update Collection]. 

The [Update Collection with USB Device] screen opens when updating of the music file 

information begins, then closes once updating is completed. 

 The following information is updated. 

- Cue Point and Loop Point 

- Hot Cue 

- Beat Grid 

- Track information (Color, Rating, Comments) 

 If you click [Cancel] during the update process, the [Update Collection with USB Device] 

window is closed. 

  



89 
 

Loading playlist files created on a DJ player 

      

Playlists created on DJ players are stored on the USB device. 

Check the playlist created on the DJ player in [Devices], then load it into [Playlists]. 

1 Click  to the left of the  onto which you want to load the playlist, then click  to 

the left of the [Playlists] folder. 

A list of playlists saved in the USB device is shown in [Devices]. 

2 Drag the playlist you want to load to [Playlists]. 

The playlist is added to [Playlists]. 

 Playlists can be also loaded by right-clicking on the playlist you want to load in [Devices] 

and then selecting [Import Playlist]. 

 If there is already a playlist with the same name in [Playlists], a number is added to the end 

of the playlist’s name. 

If there are tracks in playlists created on a DJ player that are not registered in the 

rekordbox collection, those tracks are removed when the playlist is loaded. 
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Playback connected to a LAN 

        

If you connect a computer to the DJ player with a LAN cable or by wireless LAN, the 

rekordbox music files and data can be loaded onto the DJ player in real time. 

When a PRO DJ LINK-compatible DJ mixer and the computer are connected by LAN cable, 

rekordbox music files can be monitored over the DJ mixer’s headphones. 

 

Establishing the link (displaying the link status) 

Depending on the security software used on your computer and its operating system’s settings, it 

may not be possible to establish links with DJ units. 

If this occurs, it will be necessary to clear your settings for any programs and communications 

ports that are blocked. 

1 Connect the computer and DJ units. 

When a DJ unit connected to the network is detected,  is displayed at the bottom left 

of the browser panel. 

 For instructions on connections, see the Operating Instructions for each respective DJ unit 

and computer. 

 When connected using a switching hub or a PRO DJ LINK-compatible DJ 

mixer,rekordbox music files and data can be shared with up to four DJ players. 

 Depending on the communications environment, some time may be required for the 

network address to be acquired automatically. 

2 Click . 

Communications with DJ units connected by LAN cable or wireless LAN are enabled. 
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The link status panel (icons of connected DJ units) is displayed at the bottom of the browser 

panel, and  switches to . 

 When  is displayed to the left of the link status panel, this means that there are 

two computers connected and that there is already another computer on 

which rekordbox is installed in the network. 

 When  is displayed on the left of the link status panel, this indicates that the 

computer is connected to the network by wireless LAN. 

 When [MIDI/HID] is displayed to the right of the DJ unit’s icon, this means that the DJ unit is 

communicating with another computer by USB control (MIDI or HID). 

 Rearranging the DJ units’ icons displayed on the link status panel 

The order in which the DJ unit icons are displayed on the link status panel can be rearranged to 

reflect the actual physical layout of your DJ units by dragging them left and right. 

Monitoring music files using the DJ mixer’s headphones 

   

To monitor rekordbox music files using the DJ mixer’s headphones, adjust your settings through 

the [Preferences] screen prior to performing. 

1 Drag the music file from the browser panel to the player panel. 

The music file is loaded into the player panel. 

 Music files can also be loaded into the player panel by dragging them from the browser panel 

to the  icon on the link status panel. 

2 Click [ ] on the player panel. 

Playback starts. 
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The sound of the rekordbox music file is output to the DJ mixer over the LAN cable. 

3 Monitor the sound of the DJ mixer’s [LINK] channel over headphones. 

 For instructions on operating DJ mixers, see the Operating Instructions for each respective 

DJ mixer. 

Loading music files onto a DJ player 

When the DJ player’s [LOCK] function is activated, music files cannot be loaded until playback 

on the DJ player is paused. 

Drag music files from [Collection] to  on the link status panel. 

The music file is loaded onto the DJ player, and playback starts. 

 Music files can also be loaded to the DJ player by dragging them from [Playlists], [iTunes], 

[Tag List], [Histories] and [Explorer]. 

If any music files that have not been analyzed are loaded directly from [iTunes] to your DJ player, 

the subsequent analysis processing may impact your computer’s performance. 

To lessen this burden and load music files more smoothly on the DJ player, make the settings at 

the [Preferences] screen beforehand. 

 Playing a DJ player or DJ mixer using the quantize function 

The beat grids of music files detected and adjusted using rekordbox can be used with the 

quantize function when performing cue operations and playing loops on DJ players 

(e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus, CDJ-900, XDJ-AERO, XDJ-R1). Furthermore, 

if the DJ player (e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus, CDJ-900) and DJ mixer 

(e.g. DJM-2000nexus, DJM-2000, DJM-900nexus) are connected by LAN cable, the quantize 

function can be used while you generate effects. 

 For instructions on using the quantize function on DJ players and DJ mixers, see the 

Operating Instructions for each respective DJ unit. 

 Using the beat sync function between multiple DJ players for playback 

When the beat grids of music files detected and adjusted using rekordbox are used, the sound 

can be mixed synchronizing the tempos (BPM) and beats of multiple DJ players 

(e.g. CDJ-2000nexus, CDJ-900nexus) connected by PRO DJ LINK or of the left and right decks 

(e.g. XDJ-AERO, XDJ-R1). 

 For instructions on using the beat sync function on DJ players, see the operating instructions 

of the respective DJ players. 
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By specifing the tempo (BPM) with rekordbox, the tempos (BPM) and beat positions can be 

synchronized between multiple DJ players (e.g. CDJ-2000nexus). 

 Playing back on a DJ player by using hot cues 

The hot cues (A, B and C) stored for music files can be called out on DJ players (e.g. 

CDJ-2000nexus or CDJ-2000) and played. 

 For instructions on using the hot cues (A, B and C) stored for music files on DJ players, see 

the respective DJ players’ operating instructions. 

 For some DJ players (e.g. CDJ-2000nexus, XDJ-R1), when a music file is selected and 

loaded onto the DJ player, the hot cues (A, B and C) stored for the music file can be 

simultaneously loaded, forcibly replacing the DJ player’s hot cues (A, B andC). 

 To use combinations of hot cues (A, B and C) of different music files for playback, a hot cue 

bank list must be created and loaded on the DJ player. 

 

Loading the Hot Cue Bank List into the DJ player 

  

To use combinations of hot cues (A, B and C) of different music files for playback, a hot cue 

bank list must be created ahead of time. 

Drag the hot cue bank list from the [Hot Cue Bank List] to  in the link status panel. 

The hot cue banks (A, B and C) registered in the Hot Cue Bank List are loaded into the DJ 

player’s hot cue (A, B and C) buttons. 

 

Sharing music files by using Tag List 

     

The tag list is a list allowing you to perform realtime browsing from each of the DJ players which 

are displayed in the link status panel. 

When music files are added from rekordbox to the tag list, the music files on the tag list can be 

loaded onto the DJ player and played by operating the DJ player. 
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1 Click  above the tree view and then click  on the right. 

 In order to show the taglist, you need to tick [Playlist Palette] in [Preferences] > [View] > 

[Layout]. 

2 Drag a music file from [Collection] to [Tag List]. 

The music files are added to [Tag List]. 

 Music files and playlists can also be added by dragging them from [Playlists] or [iTunes]. 

 Up to 100 files can be added. 

 Changing the order of the tracks on the tag list 

1 Click the heading of the column displaying the track order. 

Each time you click, the arrangement toggles between ascending and descending orders. 

2 Drag a music file and change the track order. 

If the songs are sorted by any column header besides that which represents the track order, a 

music file cannot be dragged and the list cannot be reordered. 

 Playback on a DJ player by using Tag List 

By operating the respective DJ players, the music files on the taglist can be loaded into and 

played on the respective DJ players, and taglists actually used during performances can be 

saved as rekordbox playlists. 

 For instructions on accessing the tag lists from the DJ players, see the Operating 

Instructions for each respective DJ player. 

Checking the play history 

You can check music files that played on DJ players connected by LAN cable or wireless LAN 

and their playing order in [Histories]. 

1 Double click [Histories] in the tree view. 

Histories appear by folders with year and month. 

Histories of playback through PRO DJ LINK are created with a name of [LINK HISTORY 

yyyy-mm-dd] in a folder of the year and month. 

2 Select [LINK HISTORY yyyy-mm-dd]. 

A list of music files in a history is shown in the track list. 
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Disconnecting links 

Click . 

Communication with DJ units 

(e.g. CDJ-2000nexus, CDJ-2000, CDJ-900nexus, CDJ-900, DJM-2000nexus, DJM-2000, DJ

M-900nexus, XDJ-AERO) connected by LAN cable or wireless LAN are terminated. 
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Additional information 

Managing music files 

Storing data using the backup function 

Regular back-up is recommended to prevent data from being lost due to computer failure or 

other potential disasters. 

Data in rekordbox such as Collection, playlists, analysis data and music files can be backed up. 

The backup function can also be used for migrating data from the current computer to a new one 

before replacing your computer with a new one. 

1 Click [File] menu > [Library] > [Backup Library]. 

A caution for backup pops up. 

Backing up many tracks stored in [Collection] may take long depending on your computer’s 

performance. 

2 Click [Yes]. 

The dialog [Do you want to back up music files as well?] pops up. 

3 Click [Yes] or [No]. 

Backing up your music files is recommended when you migrate data in the current computer 

to a new one even though it may take time. 

A dialog box is shown to select where to save the backup data. 

4 Select a place where you want to store the backup data and click [Save]. 

The backup process begins. Once the process is completed, [Collection was backed up.] is 

shown. Then, press [OK]. 
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Replacing data with the backup data using the Restore function 

Your data is replaced with the backed up data. 

1 Click on the [File] menu and select [Library] > [Restore Library]. 

Restoring many tracks stored in the backup data may take long depending on your 

computer’s performance. 

2 Click [Yes]. 

A dialog box is shown to select a backup data. 

3 Select a stored backup data (***.zip or xxx.edb) and click [Open]. 

The process of replacing the present data with the backup data begins. Once the process is 

completed, [Collection was restored.] is shown. Then, press [OK]. 

You can replace the present data with the backup data in .edb files of the 

oldrekordbox versions, too. 

 

Updating the file paths of missing music files 

rekordbox manages information on where music files are stored (file paths). If file and folder 

names are changed or if files or folders are moved or deleted, it may no longer be possible to 

play the music file. (  is displayed to the left of missing music files.) 

1 From the [File] menu, select [Display All Missing Files]. 

The [Missing File Manager] screen opens and a list of missing music files is displayed. 

2 Select the music file whose file path you want to correct, then click [Relocate]. 

The [Choose a new fullpath for] screen opens. 

3 Select the folder in which the music file is stored and the file name, then click [Open]. 

The information on where the music file is stored (file path) is corrected. 

 File paths can also be corrected by right-clicking on a music file for which  is displayed 

on [Collection] then selecting [Relocate]. 

At the [Choose a new fullpath for] screen, be careful not to select the wrong music file. 
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Setting preferences 

To change the various rekordbox settings, select [Preferences] from the [File] menu to open the 

[Preferences] screen. 

Preferences: View 

Language Sets the language to be used in the display. 

Font Sets the size of the characters. 

Artwork Selects the size of the full-size artwork displayed on the track list and Tag List. 

Layout 

Treeview 
Selects whether or not [Hot Cue Bank List], [iTunes], [rekordbox xml] 

and [Explorer] are displayed in the tree view. 

Playlist 

Palette 
Selects whether or not the Playlist palette is displayed. 

Tooltips Sets whether or not pop-up hints are displayed. 

 

Preferences: Audio 

Use “LINK MONITOR”of 

Pioneer DJ Mixers 

Sets whether or not to monitor rekordbox music files over the 

headphones of the DJ mixer connected by PRO DJ LINK. 

Audio Device Sets the audio output device. 

Sample Rate 

Sets the sampling frequency of audio data sent to an audio device. 

A high sampling rate allows the user to achieve a playback quality 

close to that of the original track. However, as the amount of audio 

data increases, the load on the audio device also increases. 

Buffer Size 

Sets the number of samples sent to an audio device for each data 

transmission. 

A large buffer size reduces audio skipping (audio interruption). 

However, as the transmission delay (latency) increases, the time gap 

also increases between the playback position of the music file 

displayed on the screen and the actual audio output. 

Output Channels 
Sets the audio output channel when there are multiple outputs from 

an audio device. 

Metronome 
Sets the tone of the metronome which sounds while you listen to the 

beat grid of a music file. 
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Preferences: Analysis 

Track 

Analysis 

Mode 

Sets the mode for analyzing the music file’s wave 

information. 

 Normal: Optimizes analysis for tracks which have a 

relatively consistent tempo 

 Dynamic: Optimizes analysis for tracks which contain 

significant tempo changes 

Allow analysis while 

LAN connected 

Sets whether or not to analyze music files added to the 

collection while linked to DJ units. 

If analysis is disabled here, processing is put on hold. 

Analysis processing that is on hold begins automatically 

after the link to the DJ unit is terminated. 

Location of analysis 

files 

Sets where to store the wave information of the analyzed 

music files. 

Key 

Analysis 

Enable Key Detection 

on import 

This sets whether or not to detect the keys when adding 

music files to collections. 

Save value to ID3 tag Detected key is written in the ID3 tag. 

 

Preferences: Bridge 

iTunes 

iTunes Library File 
Specifies the xml file of the iTunes library browsed in 

[iTunes]. 

Convert iTunes 

“Grouping” to 

rekordbox “Label” 

Sets whether or not to store iTunes group information 

asrekordbox label information when importing music file 

information from the iTunes library to the rekordboxcollection.

rekordbox 

xml 

Export Beat Grid 

information 

Sets whether or not to output the beat position information 

of rekordbox to an xml file when the rekordbox library 

information is exported. 

Imported Library 

Specifies the playlist library (the location of the xml file) that is 

browsed in [rekordbox xml]. For the latest information on 

playlist libraries that can be displayed byrekordbox, see 

the rekordbox online support site. 
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Preferences: Device 

Create library 

exclusively for 

Sets whether or not to create libraries (databases for collections, playlists, 

etc.) exclusively for the MEP-4000 or XDJ-R1 on USB devices. When set 

to create libraries, the library exclusively for the MEP-4000 orXDJ-R1 is 

created on the USB device when it is disconnected from the computer. 

 Only when [XDJ-R1] is selected and [Create 320×320 pixels size 

image] is ticked, you can export track information with 320 x 320 pixel 

artwork to a device. 

Create a library in 

a device for CDJs 

when importing 

tracks from it 

When importing tracks from an external device, a library can be 

automatically created in the device without copying the music file. 

Delete playlist 

tracks if playlist is 

deleted 

When a playlist is deleted in [Devices], the playlist in a USB device or an 

SD card is deleted. You can select whether the music files in the USB 

device or an SD card is deleted or not when the playlist is deleted.. 

Music files are deleted only if they are not being used by other playlists. 

History 
Sets whether or not histories of tracks played on CDJ are automatically 

added to [Histories] when a device is inserted. 
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Preferences: CDJ 

Category 

Specifies the category items to be used with the DJ player and the order in which 

they are displayed. For more instructions on using a DJ player’s Library Browse 

function, see the Operating Instructions for each respective DJ player. 

Sort 

Specifies the sorting items to be used with the DJ player and the order in which 

they are displayed. For more instructions on using a DJ player’s Library Browse 

function, see the Operating Instructions for each respective DJ player. 

Column 

Specifies a user-set category to be displayed to the immediate right of titles when 

browsing music files on the main unit display of the DJ player 

(e.g. CDJ-2000nexus). 

My Settings 

The DJ player’s settings can be saved in rekordbox and reflected on a DJ player 

through a USB device, a mobile device or PRO DJ LINK. This lets users 

immediately set up DJ players with the settings they are used to so you can 

devote all your attention to your performance. For details on the setting items 

that can be stored and called out with “My Settings”, see the operating 

instructions of the respective DJ player (e.g. CDJ-2000nexus). 

Hot Cue 

Sets whether or not to check [Allow to auto load Hot Cue on CDJ] on the 

[Information] pane when music files are added to the collection. When music files 

for which [Allow to auto load Hot Cue on CDJ] is checked on the[Information] 

pane are loaded into a DJ player (e.g. CDJ-2000nexus, XDJ-R1), the DJ player’s 

hot cues (A, B and C) are forcibly replaced with the hot cues (A, B and C) stored 

for the loaded music files. 

 

Preferences: Keyboard 

Keyboard Assigns keyboard shortcuts to the various buttons. 
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Preferences: Advanced 

Computer name 
Sets the name of this computer to be displayed on the DJ unit 

(e.g.CDJ-2000nexus or XDJ-AERO). 

My tag 
Selects whether or not My Tag is added to the Comment column in the 

track list. 

Color comments 

Comments on the color codes used for classifying the categories of 

music files on DJ players in eight colors can be edited. For more 

instructions on using a DJ player’s Library Browse function, see 

theOperating Instructions for each respective DJ player. 

Automatically fix 

misalignment of Beat 

Grid and/or Cue Points 

for MP3 files which 

have been imported 

before version 1.5.4 

Older versions of rekordbox (1.5.3 or earlier) used the gapless 

playback information in MP3 files encoded using LAME. Current 

Pioneer DJ players and the current version of rekordbox, however, do 

not use the gapless playback information in MP3 files encoded using 

LAME. By checking [Beat Grid], it is possible to correct the beat 

position in keeping with the specifications of current Pioneer DJ players 

and the current version of rekordbox even with MP3 files encoded 

using LAME that were analyzed/adjusted with older versions 

ofrekordbox (1.5.3 or earlier). Also, by checking [Cue Points], the cue 

and loop points of MP3 files encoded using LAME that were set with 

older versions of rekordbox (1.5.3 or earlier) can also be corrected. 

This correction processing is performed automatically and the 

information is updated when MP3 files encoded using LAME are played 

using the current version of rekordbox, when they are exported to USB 

devices, etc. 

 Settings of CDJ (Category/Sort/Column) and Advanced (Color) are commonly applied to 

multiple DJ players shown on the link status panel. 

 Settings of CDJ (Category/Sort/Column) and Advanced (Color) are applied to [Devices] as 

the default values. Settings can be changed by device. 
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Menu list 
 

[File] Menu 

Import >Import Track Analyzes music files and adds them to the collection. 

Import >Import Folder Analyzes the music files in folders and adds them to the collection. 

Import >Import Playlist 

Imports playlist files (M3U and M3U8), analyzes the music files in the 

playlists and adds them to the rekordbox library (a database for 

collections, playlists, etc.). 

Display All Missing Files 
Displays collection items that cannot be played because the music 

file has been deleted, moved, etc. 

Library >Backup Library 

Backs up the rekordbox library (a database for Collections, playlists, 

etc.), analysis information and music files. 

The backup data can be saved with the date added to the file name.

Library >Restore Library 

Restores the rekordbox library (a database for Collections, playlists, 

etc.), analysis information and music files. 

The data to be used for restoring can be selected from among 

multiple backup files. 

Export Collection in xml 

format 

Exports the information for all the playlists in the rekordbox library (a 

database for collections, playlists, etc.) and the information for the 

music files in these playlists to a single file in xml format. 

Preferences Changes various settings in rekordbox . 

Exit Closes rekordbox. 
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[View] Menu 

Full screen Displays the rekordbox window at full-screen size. 

1 Player Displays a single player in the Player panel. 

2 Players Displays two players in the Player panel. 

Simple Player 

Displays a simplified version of the player panel. 

Only the music file playback and pause and the volume adjustment 

operations can be performed. 

Full Browser 
Turns the display of the player panel off. 

Music files are played when they are double-clicked on the browser panel. 

 

[Track] menu 

Analyze Track 
Analyzes selected music files to measures a full waveform, a zoom 

waveform, BPM, beat positions, and bar positions. 

Analyze Key Detects the key of the selected track. 

Reload Tag 

Reads values of the ID3 tag from the selected music files and adds them to 

the track information of rekordbox library (a database of collections, playlists, 

etc.). 

Add To Playlist Adds a selected music file to a playlist. 

Import To 

Collection 
Analyzes and adds a selected music file to the Collection. 

Export Track Exports selected music file(s) to a device. 

Remove from 

Collection 

Removes selected music file(s) from the Collection. 

 The music file itself is not deleted. 

Show 

information 
Opens [Information] and displays information of a selected music file. 

Show in 

Explorer 
Show a folder in which a selected music file is stored in Finder or Explorer. 

Relocate Relocates the file path of a music file. 
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[Playlist] menu 

Export Playlist Exports selected playlist(s) to a device. 

Import Playlist Import a playlist in a selected [iTunes] or [rekordbox xml] to rekordbox.

Create New Playlist 
Adds a new playlist to the level of a playlist selected or in the folder 

selected. 

Create New Intelligent 

Playlist 

Adds a new intelligent playlist to the level of a playlist selected or in the 

folder selected. 

Create New Folder 
Adds a new folder to the level of a playlist selected or in the folder 

selected. 

Delete Playlist Deletes the selected playlist or intelligent playlist. 

Sort Items 

Sorts playlists in the selected folder in ascending order. 

 [Playlists] and [H. Cue Bank] in [Playlists], [H. Cue Bank] and 

[Devices] can be sorted. 

Renumber Track Order Renumbers tracks as sorted in a playlist. 

Save Playlist Info Save information of a selected playlist in text or M3U8 format. 

 

[Help] Menu 

KUVO Displays the KUVO account settings. 

Online Manual Opens the operating instructions for this software. 

Online support Connects to the online support site for this software. 

rekordbox Update 

Manager 
Connects to this software’s update site. 

About rekordbox Displays the version of this software. 
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Genre List 

If a genre name does not exist in the tag information of a music file, the genre code is converted 

into one of the following categories in English. 

0 Blues Blues 

1 Classic Rock Classic Rock 

2 Country Country 

3 Dance Dance 

4 Disco Disco 

5 Funk Funk 

6 Grunge Grunge 

7 Hip-Hop Hip-Hop 

8 Jazz Jazz 

9 Metal Metal 

10 New Age New Age 

11 Oldies Oldies 

12 Other Other 

13 Pop Pop 

14 R&B R&B 

15 Rap Rap 

16 Reggae Reggae 

17 Rock Rock 

18 Techno Techno 

19 Industrial Industrial 

20 Alternative Alternative 

21 Ska Ska 

22 Death Metal Death Metal 
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23 Pranks Pranks 

24 Soundtrack Soundtrack 

25 Euro-Techno Euro-Techno 

26 Ambient Ambient 

27 Trip-Hop Trip-Hop 

28 Vocal Vocal 

29 Jazz+Funk Jazz+Funk 

30 Fusion Fusion 

31 Trance Trance 

32 Classical Classical 

33 Instrumental Instrumental 

34 Acid Acid 

35 House House 

36 Game Game 

37 Sound Clip Sound Clip 

38 Gospel Gospel 

39 Noise Noise 

40 Alternative Rock Alternative Rock 

41 Bass Bass 

42 Soul Soul 

43 Punk Punk 

44 Space Space 

45 Meditative Meditative 

46 Instrumental Pop Instrumental Pop 

47 Instrumental Rock Instrumental Rock 

48 Ethnic Ethnic 
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49 Gothic Gothic 

50 Darkwave Darkwave 

51 Techno-Industrial Techno-Industrial 

52 Electronic Electronic 

53 Pop-Folk Pop-Folk 

54 Eurodance Eurodance 

55 Dream Dream 

56 Southern Rock Southern Rock 

57 Comedy Comedy 

58 Cult Cult 

59 Gangsta Gangsta 

60 Top 40 Top 40 

61 Christian Rap Christian Rap 

62 Pop/Funk Pop/Funk 

63 Jungle Jungle 

64 Native American Native American 

65 Cabaret Cabaret 

66 New Wave New Wave 

67 Psychedelic Psychedelic 

68 Rave Rave 

69 Showtunes Showtunes 

70 Trailer Trailer 

71 Lo-Fi Lo-Fi 

72 Tribal Tribal 

73 Acid Punk Acid Punk 

74 Acid Jazz Acid Jazz 
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75 Polka Polka 

76 Retro Retro 

77 Musical Musical 

78 Rock & Roll Rock & Roll 

79 Hard Rock Hard Rock 

80 Folk Folk 

81 Folk/Rock Folk/Rock 

82 National Folk National Folk 

83 Swing Swing 

84 Fast Fusion Fast fusion 

85 Bebop Bebop 

86 Latin Latin 

87 Revival Revival 

88 Celtic Celtic 

89 Bluegrass Bluegrass 

90 Avantgarde Avantgarde 

91 Gothic Rock Gothic Rock 

92 Progressive Rock Progressive Rock 

93 Psychedelic Rock Psychedelic Rock 

94 Symphonic Rock Symphonic Rock 

95 Slow Rock Slow Rock 

96 Big Band Big Band 

97 Chorus Chorus 

98 Easy Listening Easy Listening 

99 Acoustic Acoustic 

100 Humour Humour 
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101 Speech Speech 

102 Chanson Chanson 

103 Opera Opera 

104 Chamber Music Chamber Music 

105 Sonata Sonata 

106 Symphony Symphony 

107 Booty Bass Booty Bass 

108 Primus Primus 

109 Porn Groove Porn Groove 

110 Satire Satire 

111 Slow Jam Slow Jam 

112 Club Club 

113 Tango Tango 

114 Samba Samba 

115 Folklore Folklore 

116 Ballad Ballad 

117 Power Ballad Power Ballad 

118 Rhythmic Soul Rhythmic Soul 

119 Freestyle Freestyle 

120 Duet Duet 

121 Punk Rock Punk Rock 

122 Drum Solo Drum Solo 

123 A Capella A Capella 

124 Euro-House Euro-House 

125 Dance Hall Dance Hall 

126 Goa Goa 
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127 Drum & Bass Drum & Bass 

128 Club-House Club-House 

129 Hardcore Hardcore 

130 Terror Terror 

131 Indie Indie 

132 BritPop BritPop 

133 Negerpunk Negerpunk 

134 Polsk Punk Polsk Punk 

135 Beat Beat 

136 Christian Gangsta Rap Christian Gangsta Rap 

137 Heavy Metal Heavy Metal 

138 Black Metal Black Metal 

139 Crossover Crossover 

140 Contemporary Christian Contemporary Christian 

141 Christian Rock Christian Rock 

142 Merengue Merengue 

143 Salsa Salsa 

144 Thrash Metal Thrash Metal 

145 Anime Anime 

146 Jpop Jpop 

147 Synthpop Synthpop 
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Disclaimer 

Please note that Pioneer cannot accept responsibility for legality, morality or reliability of 

operation with regard to use of this software by customers. Problems in operation of this software 

may arise due to the operating environment of the customer’s computer and of this software, as 

well as due to combinations with other software. 

Please note that Pioneer cannot accept responsibility for loss of information registered by the 

customer using this software. Please make a separate note of information you have registered 

and store it in a safe place. 

Music files that can be loaded and played (file formats) 

Please note that only the music files listed in the table below can be loaded and played with this 

software. 

File formats 

Music 

files 

Compatible 

formats 

Encoding 

method 

Bit 

depth
Bit rate Sampling frequency 

File 

extension

MP3 

files 

MPEG-1 

AUDIO 

LAYER-3 

CBR, VBR 16 bit
32 kbps to 

320 kbps 

32 kHz, 44.1 kHz,  

48 kHz 
.mp3 

MPEG-2 

AUDIO 

LAYER-3 

CBR, VBR 16 bit
16 kbps to 

160 kbps 

16 kHz, 22.05 kHz, 

24 kHz 
.mp3 

AAC 

files 

MPEG-4 AAC 

LC 
CBR, VBR 16 bit

8 kbps to 

320 kbps 

16 kHz, 22.05 kHz, 

24 kHz, 32 kHz,  

44.1 kHz, 48 kHz 

.m4a, .mp4

WAVE files 
Uncompressed 

PCM 

16 bit, 

24 bit
— 44.1 kHz, 48 kHz .wav 

AIFF files 
Uncompressed 

PCM 

16 bit, 

24 bit
— 44.1 kHz, 48 kHz .aif, .aiff 

 It may not be possible to read or play music files including both audio and video or 

copyright-protected music files. 

 For music files (file formats) that can be loaded and played on Pioneer DJ players, see 

the Operating Instructions for each respective DJ player. 
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Writable recording media (file system) 

Please note that this software can only write to SD memory cards and USB devices (flash 

memory or hard disks) listed in the table below. 

 

File system 

Recording media FAT16 FAT32 NTFS HFS HFS+ 

SD memory cards      

USB devices      

 To check the compatibility of SD memory cards and USB devices (flash memory or hard 

disk) with your Pioneer DJ players, see the Operating Instructions for each specific DJ 

player. 

 For the latest information on Pioneer DJ players that can be used in combination 

with rekordbox, see the rekordbox online support site. 

 HFS+ is only available for Mac OS X. 
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Communications environment on the computer (programs, OSs and networks) 

Depending on the security software used on your computer and its operating system’s settings, 

communications with DJ units or mobile devices may be interrupted. 

If this occurs, it will be necessary to check your settings for the following four programs to ensure 

that they are not blocked: 

 rekordbox.exe 

 PSvNFSd.exe 

 PSvLinkSysMgr.exe 

 edb_streamd.exe 

When sharing of the computer’s Internet connection is enabled, problems may arise in 

communications with other computers or DJ units connected on the LAN. Disable sharing of the 

computer’s Internet connection before connecting the computer to the LAN. 

The computer’s Internet connection sharing is deactivated as described below. 

 Mac OS X: Open [System Preferences], then at [Internet & Network], uncheck [Internet 

Sharing] under [Sharing]. 

 Windows: Open [Local Area Connection Properties], then at [Sharing], uncheck [Allow 

other network users to connect through this computer’s Internet connection] under 

[Internet Connection Sharing]. 

Communications with DJ units or mobile devices may also be interrupted if the network (IP 

address, port number, etc.) is restricted by a router or other communications device. 

For details on the communications devices, security software and the settings of the operating 

system you are using, contact the respective manufacturer or your sales agent. 
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Using the online support site 

Before making inquiries on rekordbox operating procedures or technical issues, read 

therekordbox online manual and check the FAQ provided on the rekordbox online support site. 

<rekordbox online support site> 

http://rekordbox.com/ 

 User registration on the rekordbox online support site is required prior to making inquiries 

concerning rekordbox. 

 Be careful not to forget the log-in name (your e-mail address) and password specified when 

you registered. 

 PIONEER CORPORATION collects your personal information for the following purposes: 

1. To provide customer support for your purchased product 

2. To inform you of product or event information by e-mail 

3. To obtain feedback collected by survey for product planning purposes 

- Your personal information is kept confidential corresponding to the privacy policy set forth 

by our company. 

- Pioneer’s privacy policy can be viewed on the rekordbox online support site. 

 When making inquiries regarding rekordbox, please be sure to furnish your computer type 

and specifications (CPU, installed memory, other connected peripherals, etc.), the operating 

system and version used, as well as concrete information regarding the issue at hand. 

- To inquire about configuring your computer with non-Pioneer peripheral devices and to 

obtain the corresponding technical support, contact the specific manufacturer or retailer. 

 Further version updates are anticipated for improved functionality and performance 

ofrekordbox. Update programs will be available for download on the rekordbox online support 

site. We strongly recommend you perform these updates and always use the latest version of 

rekordbox. 
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Copyright warning 

 The use of rekordbox is restricted with regard to the playing and copying of copy-protected 

music contents. 

- The program may not operate properly if copy-protect encryption data is embedded in 

recorded media. 

- Playback, analysis, and other operations may stop if copy-protect encryption data is 

detected to be embedded in recorded media. 

 The materials you record are for your own listening enjoyment, and cannot be used for other 

purposes without permission from the copyright owner. 

- Music recorded from CDs and other media may be protected by the copyright laws of 

individual countries as well as by international convention. You are solely responsible for 

the lawful use of the recordings you make. 

- When handling music that has been downloaded over the Internet, the person who has 

downloaded the music is fully responsible for using the music in compliance with his/her 

contract with the site from which the music was downloaded. 
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Trademarks, licenses, etc. 

 Pioneer and rekordbox are trademarks or registered trademarks of the PIONEER 

CORPORATION. 

 Microsoft and Windows are either registered trademarks or trademarks of Microsoft 

Corporation in the United States and/or other countries. 

 Apple, Finder, iPhone, iTunes, Macintosh, and Mac OS are trademarks of Apple Inc., 

registered in the U.S. and other countries. 

 App Store is a service mark of Apple Inc. 

 Android and Google Play are trademarks of Google Inc. 

 Wi-Fi is a registered mark of the Wi-Fi Alliance. 

 The audio compression technology for MP3 is offered under the license of Fraunhofer IIS and 

Thomson Multimedia. 

This product has been licensed for nonprofit use. This product has not been licensed for 

commercial purposes (for profit-making use), such as broadcasting (terrestrial, satellite, cable 

or other types of broadcasting), streaming on the Internet, Intranet (a corporate network) or 

other types of networks or distributing of electronic information (online digital music 

distribution service). You need to acquire the corresponding licenses for such uses. For 

details, visit http://www.mp3licensing.com . 

 The names of companies and products mentioned herein are the trademarks of their 

respective owners. 
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